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Prologo

Este manual ha sido creado por Hologic®, Inc. Tiene el objetivo de guiar al usuario durante la configuracion, la instalacion y el
uso del hardware Faxitron Path, asi como del sistema de software Vision, ambos desarrollados por Hologic® Inc.

Faxitron Path anteriormente recibia el nombre PathVision

El usuario debera configurar primero el hardware y, a continuacion, iniciar el software Vision. Antes de continuar, revise los
procedimientos de configuracion obligatorios incluidos en la segunda parte de este manual.

Indicaciones de uso

El sistema Faxitron Path es un armario de rayos X que se utiliza para obtener imagenes de rayos X de pelicula o digitales de
especimenes procedentes de varias regiones anatomicas con el fin de verificar rdpidamente que durante la biopsia se haya
extirpado el tejido correcto. Realizar la verificacion directamente en la misma sala o en sus proximidades permite que los
casos se concluyan mas rapidamente, limitando asi el tiempo necesario para explorar al paciente. La radiografia de los
especimenes puede limitar potencialmente el numero de citas para los pacientes.

v'Uso con receta médica (parte 21 CFR 801, subparte D)
Precaucion: De acuerdo con la legislacion federal, la venta de este instrumento queda restringida a los médicos o por

prescripcion de los mismos.

El sistema puede funcionar como un dispositivo auténomo. Si se conecta a una red, es fundamental que se implementen
medidas para reducir el riesgo para los pacientes disminuyendo la probabilidad de que la funcionalidad del dispositivo se vea
comprometida, intencionada o involuntariamente, por una ciberseguridad inadecuada.

(1]

www.hologic.com/package-inserts
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SECCION 1
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Este manual ha sido creado por Hologic, Inc. Tiene el objetivo de guiar al usuario avanzado
durante la configuracion, la instalacion y el uso del hardware Faxitron Path, asi como del
software Vision, ambos desarrollados por Hologic, Inc.

Antes de utilizar el sistema, lea atentamente toda esta informacién. Siga todas las
advertencias y precauciones indicadas en este manual. Tenga este manual a mano durante
los procedimientos. Siga siempre todas las instrucciones de este manual. Hologic, Inc. no
asume la responsabilidad de las lesiones o los dafios derivados de un uso incorrecto del
sistema. Hologic puede organizar un curso de formacién en su centro.

Gracias de parte de todos los que integramos Hologic, Inc.

Fabricante e informacion de contacto

-

PATROCINADOR DE AUSTRALIA
Hologic (Australia and New Zealand) Pty Ltd

Hologic, Inc. Suite 302, Level 3

600 Technology Drive 2 Lyon Park Road

Newark, DE 19702 USA Macquarie Park NSW 2113
1.800.447.1856 Australia
www.hologic.com 1.800.264.073

Hologic BV

Da Vincilaan 5
1930 Zaventem

Bélgica

Tel.: +322 711 46 80
Fax: +32 2 725 20 87

En este manual y en el sistema de ayuda en linea, se utilizan los siguientes simbolos:

BB PP P

Advierte al lector de una posible electrocucion en caso de que ignore la
advertencia y utilice deliberadamente herramientas especificas para abrir un
armario eléctrico precintado y manipular su contenido. Nota: Hologic, Inc. no
proporciona ninguna herramienta.

Advierte al lector de una situacion de peligro. Por lo general, este simbolo va
acompaniado de un simbolo mas especifico y de las instrucciones pertinentes
en cuanto a la naturaleza del peligro, el resultado esperado del peligro y la
informacién para evitarlo.

Advierte al lector de que debe tener cuidado al levantar equipos pesados para
evitar generar lesiones corporales y dafios al equipo.

Advierte al lector de que en el area etiquetada se emite una radiacion ionizada
cuando el haz de rayos X esta bajo tensién. El sistema Faxitron Path dispone
de enclavamientos de seguridad que evitan que se acceda a la zona etiquetada
mientras el haz de rayos X esta bajo tensién.

Advierte al lector que utilice la proteccion adecuada (como guantes quirdrgicos o
un recipiente autorizado para especimenes) con el fin de evitar la exposiciéon a
materiales potencialmente infecciosos, como las muestras de tejidos del paciente.

Introduccién

Simbolos de
advertenciay
precaucion
incluidos en este
manual
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=

electrénicos de los desechos
normales. Envie el material
desmantelado a Hologic o
contacte con su
representante de atencién
al cliente.

Simbolo Descripcion Estandar
Para desecharlos, separe los | Directiva RAEE
dispositivos eléctricos y 2012/19/UE

Fabricante

ISO 15223-1,
referencia 5.1.1

Fecha de fabricaciéon

ISO 15223-1,
referencia 5.1.3

Radiacion ionizante I1SO 7010,
emitida cuando se activa el |referencia W003
haz de rayos X
Advertencia para utilizar  |ISO 7010,
proteccion adecuada referencia W009
Advertencia sobre IEC 60417,
electricidad referencia 6042
Advertencia 1SO 7010,
referencia W001

=B BB PR

www.hologic.com/package-inserts

Consulte las instrucciones
de uso

1SO 15223-1,
referencia 5.4.3

O

Siga las instrucciones de
uso

IEC 60601-1,
referencia n.2

Tabla D.2, Sefial de

seguridad 10
(ISO 7010-M002)

Este sistema transmite
energia de radiofrecuencia
(RF) (radiacion
electromagnética no
ionizante)

IEC 60417,
referencia 5140

1.1.1
Simbolos de
advertenciay
precaucion

en las etiquetas
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Simbolo Descripcion Estandar
Representante autorizado |ISO 15223-1,
EC |REP en la Comunidad Europea |referencia 5.1.2

Producto sanitario

I1SO 15223-1,
referencia 5.7.7

Numero de catalogo

1SO 15223-1,
referencia 5.1.6

Numero de serie

I1SO 15223-1,
referencia 5.1.7

Pais de fabricacion

ISO 15223-1,
referencia 5.1.11

Traducciones en la caja

Hologic

Precaucion

I1SO 15223-1,
referencia 5.4.4

Limite de humedad

I1SO 15223-1,
referencia 5.3.8

LisTED

Intertek

Certificacién ETL

Consejo de
Normalizacion de
Canada

(SCO)y
Administracion de
Salud y Seguridad
Laboral de EE. UU.
(OSHA)

KRonLy

Solo con receta

FDA 21 CFR
801.109

o

Corriente alterna

IEC 60417,
referencia 5032

C€

Marca CE

Conformidad europea

Reglamento MDR
(UE) 2017/745

A

Advertencia; haz laser

ISO 7010,
referencia W004
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Simbolo

Descripcion

Estandar

Bus serie universal (USB),
puerto/enchufe

ISO 7000-3650

Precaucion: radiacion Hologic
W (se producen rayos X)
Fusible IEC 60417,
_E_ referencia 5016
| Tierra IEC 60417-5017

Cuidado al levantar Hologic
objetos pesados

Nota Hologic
2
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SECCION 2
Instalacion y configuracioén
de Faxitron Path
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Advertencias

e Antes de utilizar el sistema, lea atentamente las instrucciones. Advertencias y

* No utilice el sistema de manera distinta a la del uso previsto, tal y como se describe en p_recaucmnes del
este manual. En caso de duda, pdngase en contacto con Hologic o con el distribuidor sistema
autorizado.

e No todos los cables de alimentacion tienen la misma clasificacion. No utilice con este
sistema ningun otro cable de alimentacion que no sea el suministrado. No utilice el cable
de alimentacion de este sistema en ningun otro equipo.

e Este sistema ha sido probado siguiendo las normas internacionales mas estrictas; no
obstante, en lo relativo a los requisitos operativos locales es recomendable que se ponga
en contacto con las autoridades nacionales.

o Este sistema no esta destinado al uso publico. Debera estar situado en una zona en la
que el publico en general no pueda acceder al sistema sin la presencia de un operador.

Precauciones generales
Para evitar producir dafios al sistema Path, deberan tomarse las siguientes precauciones:

e Mientras el sistema esté encendido, nunca conecte ni desconecte los cables de
comunicacion y/o alimentacién. Si los cables se conectan o desconectan mientras la
camara esta encendida, podran producirse dafios en el sensor CMOS o en los
componentes electrénicos de la camara.

o El sistema de camara es fragil y se debe tener cuidado para no dafiarlo. El sistema de
camara nunca se debera manipular incorrectamente, golpear bruscamente, golpetear ni
dejar caer.

e El sistema Path dispone de un modo de calibracién. Para garantizar el correcto
funcionamiento del sistema, la calibraciéon debera llevarse a cabo diariamente. Consulte el
Procedimiento de calibracion.

e Precaucion: el uso de controles o los ajustes para realizar procedimientos distintos de los
especificados en el presente documento podra provocar la exposicion peligrosa a la
radiacion.

Conexiones interoperativas

El Path es capaz de funcionar como un dispositivo auténomo, sin entradas ni salidas hacia
otros dispositivos. En el sistema, las imagenes se pueden captar, almacenar y revisar
directamente.

Sin embargo, el sistema dispone de varias interfaces. La principal es la conexion de red
que permite conectar el sistema a un Sistema de archivo y comunicacion de imagenes
(SACI). Las imagenes pueden ser transmitidas en formato DICOM desde el dispositivo
directamente a la red del centro a través de nuestro software. Para obtener mas detalles
sobre la version de DICOM, consulte la seccién 6. Solamente deberan configurar esta
comunicacion los empleados de Hologic o el personal de Tl capacitado del centro del
usuario.

A continuacién, se enumeran las conexiones del sistema y el uso previsto. Ningun otro tipo
de dispositivo debera conectarse al Path sin la aprobacion de Hologic.

HOLOGIC
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Conexion Propésito Tipo de dispositivo | Usuarios a los que va dirigido
Puerto Almacenar imagenes radiograficas en un | SACIl o Configurado por el personal de

Ethernet de la
parte posterior

sistema de almacenamiento de datos en
red.

almacenamiento en
red

Hologic o de Tl del centro.
Utilizado por profesionales clinicos.

Puerto
Ethernet de la
parte posterior

Permitir la conexion remota por parte del
equipo de mantenimiento de Hologic
para que Hologic pueda diagnosticar y
reparar el sistema.

Conexion a Internet
en red

Personal de Hologic o de Tl del
centro.

Puerto USB de
la parte frontal

Transferir imagenes desde el dispositivo.
Este solamente se debera utilizar si el
SACI o la red no estan disponibles.

Dispositivo de
almacenamiento
USB (memoria flash)

Profesionales clinicos o de Tl que
tenga acceso autorizado al sistema.

Puerto USB de
la parte frontal

Mantener y conservar los archivos del

sistema; es posible que sea necesario
copiarlos en y desde el ordenador. Por
ejemplo, actualizaciones de software o
archivos de registro.

Dispositivo de
almacenamiento
USB (memoria flash)

Personal de Hologic o de Tl del
centro.

Puerto USB de
la parte
posterior

Permitir la conexién de una impresora. El
software Vision permite la conexion de
una impresora DICOM o una impresora
estandar compatible con Windows.

Impresora DICOM o
Windows

Profesionales clinicos o de Tl del
centro.

Ciberseguridad

La seguridad de los dispositivos es una responsabilidad compartida entre Hologic y los
centros médicos. Si no se mantiene la ciberseguridad, se podra poner en peligro la
funcionalidad del dispositivo, la disponibilidad o la integridad por la pérdida de los datos
(médicos o personales), o la exposicion a amenazas de seguridad de otros dispositivos o

A

redes conectados. Para asegurar la ciberseguridad de sus unidades y conservar su

funcionalidad y seguridad, Hologic mantiene una serie de controles de ciberseguridad.

Todas nuestras unidades utilizan el sistema operativo estandar de Windows. Durante la
instalacion, recomendamos que el centro implante todas las medidas de seguridad que sean
necesarias y estén definidas por sus propios requisitos internos, como lo haria con cualquier
otro PC conectado a la red.

El centro podra configurar el sistema operativo Windows con todos los protocolos de red y
permisos necesarios. Por ejemplo, podra afadir:

. ID y contrasefias de usuarios,
» autorizacién por niveles con la autenticacion correspondiente,
* restricciones a la instalacién del software,
*  requisitos de contenido de confianza, incluida la verificacion del codigo de la firma,

«  configuracion de las actualizaciones de Windows, incluidas las versiones de seguridad.

Ademas, nuestro software de imagenes (Vision) se puede proteger mediante contrasefia
para que determinados usuarios puedan acceder al sistema operativo sin tener que abrir el

software Vision.

La unidad viene con una llave fisica que enciende el sistema de rayos X. Esto permite que
el sistema se bloquee, por lo que incluso si se accede al software no se pueden iniciar los

rayos X.

Esta unidad esta disefiada para utilizarse como unidad independiente o conectarse al SACI
interno del centro o a otra red de circuito cerrado. No esta previsto que se conecte a Internet,
a menos que: (a) el centro reciba de Hologic instrucciones especificas para hacerlo, o (b) el
centro tome las precauciones adecuadas que garanticen la ciberseguridad de la unidad
frente a las amenazas relacionadas con la conexion a Internet.

Para seguir garantizando la seguridad del producto segun sea necesario durante todo el
ciclo de vida de la unidad, Hologic desarrollara actualizaciones o parches para el software

Vision.
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SECCION
Instalacién y
configuracion

Se podran implementar medidas de seguridad adicionales, incluido el cifrado, y Hologic
podra trabajar con el departamento de Tl de los centros para reducir el riesgo de los
pacientes como resultado de una violacion de la ciberseguridad.

Limpieza
Compartimento interno

Las muestras que contienen especimenes biolégicos pueden albergar agentes infecciosos
que son peligrosos para la salud. Siga los correspondientes procedimientos de
bioseguridad; cuando manipule especimenes de tejido o cualquier material con el que entren
en contacto, utilice guantes.

Limpie periédicamente el interior del armario con alcohol isopropilico al 70-90 % o hipoclorito
de sodio diluido (la lejia doméstica al 5,25 %-6,15 % diluida en la proporcién 1:500 ofrece la
concentracion adecuada). Asegurese de que el area de especimenes, marcada en la base
de la camara, esté bien limpia.

Compartimento externo

Limpie periédicamente las superficies exteriores con alcohol isopropilico, hipoclorito de
sodio, 0 agua con jabdn suave (consulte mas arriba las concentraciones correspondientes).
No empape ni inunde las superficies, ni utilice abrasivos que puedan rayarlas. No permita
que la humedad entre en contacto con ninguno de los componentes eléctricos del sistema.
Para verificar que no deterioran el acabado, pruebe los productos de limpieza en un area
pequefia y poco visible de las cubiertas metalicas y de plastico.

2.1.0 Cont.
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SECCION
Instalacién y
configuracion

Inspeccion de las cajas

El sistema Faxitron Path se presenta en dos cajas, una de ellas una caja de madera de
grandes dimensiones. Solicite al transportista las lleve a un area donde puedan mantenerse
a salvo de robos, dafios o condiciones ambientales extremas hasta que el representante
autorizado de Hologic pueda instalar el sistema.

Compruebe que no estén dafiadas. Si cualquiera de ellas parece estar dafiada, péngase en
contacto con Hologic llamando al +1 -800-447-1856.

La caja de madera mide alrededor de 1,2 m (4 pies) de alto. Contiene la unidad de
especimenes, un ordenador y los manuales del sistema. La otra caja contiene el monitor del
sistema.

Elevacién y transporte de las cajas de madera

Precaucion: la caja pesa aproximadamente 250 kg (550 libras). El sistema embalado debe
mantenerse en posicion vertical, como aparece indicado en la caja del envio.

Desempaquetado y montaje del sistema

El sistema Faxitron Path debe desembalarse y configurarse por un representante autorizado
de Hologic, Inc.

Ubicacion
La ventilacion y el conector de alimentacion del sistema Faxitron Path se encuentran en la
parte posterior del armario. Para permitir que el aire circule adecuadamente y que el usuario

pueda desconectar el cable de alimentacion, cuando instale la unidad deje al menos 15 cm
(6 pulgadas) de espacio libre detras de la misma.

2.2.0

Configuracion
del sistema Path
de Faxitron
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Sistema de radiografia de muestras configuracic')n

Condiciones ambientales

Operativas: Especificaciones
Temperatura: entre 15,5y 30 grados C (entre 60 y 86 grados F).
Humedad relativa: <75 %.

Almacenamiento y transporte:
Temperatura: entre 0 y 45 grados C (entre 32 y 113 grados F).
Humedad relativa: <75 %.

Este equipo esta disefiado para funcionar en las siguientes condiciones:

e Uso en interiores

e Altitud hasta 2000 metros (6562 pies)
e Contaminacion de grado 2

e Categoria de sobretension Il

Una vez instalado, el Faxitron Path no debe moverse. El sistema fue disefiado como un
sistema estacionario para ser instalado en un mostrador o mesa.

PROTECCION RADIOLOGICA

e Armario con proteccion frente a radiacion.
e Puerta del compartimento equipada con enclavamientos de seguridad dobles.

e Radiacion: por debajo de 1 uSv/h (0,1 mR/h) a5 cm (2 pulgadas) de la superficie exterior
al maximo voltaje.

e Garantia de cumplimiento de las normas establecidas por el Centro de Aparatos y Salud
Radiolégica de la Administracion de Alimentos y Medicamentos de los Estados Unidos,
(21 CFR 1020.40).

o Disefiado conforme a las normas fijadas por Underwriters Laboratories (EE. UU. y Canada).

e Hologic recomienda que los usuarios reciban formacion basica en seguridad frente a la
radiacion ionizante antes de utilizar el sistema.

CONTROL DE LA EXPOSICION: automatico o manual.

CICLO DE TRABAJO DE LOS RAYOS X: 50 %

INFORMACION DEL LASER: producto laser de clase 2
IEC 60825-1 Ed. 3

De acuerdo con las normas 21 CFR 1040.10 y 1040.11,
a excepcion de las desviaciones contempladas en el aviso
sobre laser n.° 50 del 24 de junio de 2007.

REQUISITOS DE POTENCIA: méaximo de 100-240 VCA, 50/60 Hz, 200 VA
POTENCIA CALORIFICA: maximo de 527,5 kJ/h (500 BTU/h)

Fluctuaciones de tension de la red de suministro eléctrico principal de hasta +10 %
de la tension nominal

Especificaciones del tubo de rayos X:

Punto focal < 12 micras

Tension: de 20 a 100 kV

Potencia: max. 12 vatios

Cobertura de radiacion: 45 grados
Ciclo de trabajo de los rayos X: 50%
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Faxitron® Path

Sistema de radiografia de muestras

SECCION

Instalacién y

configuracion

kV  |Corriente del haz (mA)| Potencia (W)
20 0,375 15

30 0,375 11,25

40 03 12

50 0,24 12

60 02 12

70 0,171 12

80 0,15 12

80 0,133 12

100 0,12 12

DIMENSIONES EXTERNAS (aproximadas)

Corriente del haz (mA)

2.3.0 Cont.

Rango operativo de los rayos X

Tensién del tubo (kV)

#-— Corriente del haz (mA)  —@— Potencia (W)

cm pulgadas
Altura 90 36
Anchura 59 23
Profundidad 54 21

DIMENSIONES INTERNAS DEL COMPARTIMENTO (aproximadas)

cm pulgadas
Altura 57 22,3
Anchura 39 15,5
Profundidad 42 16,5

PESO (aproximado)

Con Ordenador, monitor, teclado y accesorios
kg b

Neto 210 465

Del paquete 258 570
Solo el armario

Neto 188 415

Del paquete 236 520
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Faxitron® Path

Sistema de radiografia de muestras

SECCION

Instalacién y
configuracion

2.3.0 Cont.
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Faxitron® Path Shocion 3

Sistema de radiografia de muestras de la cAmara

SECCION 3
Calibracion de la camara
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Faxitron® Path Shocion

Sistema de radiografia de muestras de la cAmara

Calibracion 3.1.0

En el momento de la puesta en marcha inicial del sistema, o en cualquier momento deseado ~ Calibracion
por el usuario, se podra realizar la calibracion del sistema. Tras la puesta en marcha inicial y
transcurrido un periodo de doce (12) horas, deben realizarse las siguientes calibraciones.

Para optimizar la calidad de las imagenes, el software Vision y el hardware requieren la
realizacion periddica de la calibracion. Esta calibracion requiere la obtencién de imagenes de
referencia. Dichas imagenes se pueden agrupar en tres (3) categorias: imagenes
desplazadas, imagenes oscuras e imagenes de campo plano.

El software Vision se abrira directamente en Home Menu (Menu de inicio; Figura 3.1.1)
o en la pagina Calibration (Calibracion; Figura 3.1.2) dependiendo del tiempo
transcurrido desde la ultima calibracion del sistema. Para iniciar manualmente una
calibracioén, dirijase a la pagina Calibration (Calibracion).

Precaucion: antes de iniciar la calibracion, verifique que el compartimento esté vacio.

Para iniciar manualmente una calibracién, haga clic en el botéon «Calibrate» (Calibrar) de
Home Menu (Menu de inicio).

Figura 3.1.1
Botén Calibrate para calibrar el
sistema
Start Procedure
>
Calibrate Review Shut Down
A continuacion, se pedira la confirmacion del usuario mediante la seleccion de «Start
Calibration» (Iniciar calibracion).
Figura 3.1.2

Mensaje Start Calibration para
iniciar la calibracion

Start Calibration

Last Calibrated: 20 1 14:41:53 Tue

Calibration before beginning any procedure is recommended

Cuando pulse, se llevara a cabo el proceso de calibracion y se mostrara un cuadro de mensaje
de la misma. Durante la calibracion, el cuadro de mensaje alternara entre «<SYSTEM IN
CALIBRATION» (SISTEMA EN CALIBRACION) y «X-RAY ON» (RAYOS X ENCENDIDOS).
Véase la Figura 3.1.3.

Figura 3.1.3

I

Calibrating

‘5‘ SYSTEM IN CALIBRATION

El software volvera de forma automatica al Home Menu (Menu de inicio) cuando se complete
la calibracion.

Para obtener mas informacién sobre la calibracién, consulte las secciones 5.2.0y 5.2.1.
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Faxitron® Path SECCION 4

Sistema de radiografia de muestras Inicio rapido

SECCION 4

Inicio rapido:
funcionamiento basico de
Faxitron Path
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Faxitron" Path

Sistema de radiografia de muestras Inicio répido

Antes de encender el sistema, asegurese de que todos los cables estén bien enchufados en

el sistema, el ordenador y el monitor. . . L, .
y Inicio rapido

Consulte la Seccién 2 de este manual, Instalacion y configuracion, y las guias de

configuracion rapida y de inicio rapido suministradas con el sistema Path.

Figura 4.1.1
Panel frontal de Faxitron Path

Tecla de
encendido/
apagado

Protocolo de la secuencia de puesta en
marcha del sistema

Para garantizar que el funcionamiento del sistema y la calidad de las imagenes sean los
adecuados, debera seguirse esta secuencia de puesta en marcha:
Sistema de encendido

e Coloque el interruptor de alimentacion de la parte posterior del armario Path en la
posicion «ON».

e Gire la llave de contacto de la parte frontal del armario Path hasta «ON» (en el
sentido de las agujas del reloj a la posicion de las tres).

e Encienda el ordenador y el monitor.

Inicio del software i
Figura 4.1.2

e Compruebe que no haya nada en el compartimento de rayos X del Icono de escritorio de Vision
Path.

e El software Vision deberia iniciarse automaticamente cuando el
sistema operativo Windows haya terminado de arrancar. Si el
software no se inicia automaticamente, haga doble clic en el icono
de Vision que se encuentra en el escritorio de Windows.

Calibrar

e En el momento de la puesta en marcha inicial del dia el software deberia abrirse en
la pagina Calibration (Calibracién).

e Presione el botén «Calibrate» (Calibrar) y permita que el sistema complete la calibracion.

Recomendaciones extra para obtener una calidad de imagen 6ptima.

Cada dia, antes de comenzar a utilizar el sistema, permita que se realice una calibracion
completa en el mismo. El sistema esta configurado para realizar dicha calibracion en el
momento en que inicie el software Vision.

Después de trasladarlo a otra habitacion, lleve a cabo una calibracién completa del sistema
para evitar posibles problemas en la obtencién de imagenes relacionados con las diferencias
de temperatura y humedad ambiente entre las habitaciones.
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Faxitron® Path SECCION

Sistema de radiografia de muestras Inicio répido

Procedimientos basicos de obtencién de imagenes 4.2.0

Obtencion de
Advertencia: el uso de Path de una manera diferente a la descrita en este manual podria

provocar un mal funcionamiento del equipo o lesiones personales. Imagenes
Advertencia: para evitar el contacto con muestras de tejido de pacientes que sean
potencialmente peligrosas, utilice recipientes o guantes autorizados. 52
Start Procedure (Iniciar procedimiento)
e En la pagina Home Menu (Menu de inicio), seleccione el botén Start Procedure

(Iniciar procedimiento).

Figura 4.1.3
Home Menu (Menu de inicio)
del programa Vision (pantalla

Start Procedure principal)
P |
O ©), 9
Review Help Shut Down
e Al usuario se le daran las opciones Select from Work List (Seleccionar en la lista
de trabajo), Manual Entry (Introducciéon manual), Select from Database
(Seleccionar en la base de datos) o Continue with current patient (Continuar con
el paciente actual).
e Para introducir manualmente un nuevo procedimiento, seleccione el boton Manual
Entry (Introduccién manual).
Figura 4.1.4
< Opciones de Start Procedure
(Iniciar procedimiento)

Continue with current patient Select from Database E
Camarated G034

e Se abrira el cuadro de didlogo «Patient Information Editor» (Editor de la informacion
sobre el paciente).

HOLOGIC

MANUAL DE USUARIO DE FAXITRON PATH | HOLOGIC | REVISION 002 4-3




Faxitron" Path

Sistema de radiografia de muestras

SECCION
Inicio rapido

Patient Name:

Patient ID:

*

Accession #: t N 123456789

Date of Birth: 1920/03/16

Sex:

Procedure Name:

Laterality:

*

Position View:
Body Part:
Refer. Physician:
Technician:

Technician ID:

Study Name:

Study ID:

ot |
T
I
¢
¢
¢
¢
|
|
-
|
A

>

Accept

< Start a New Patient or Procedure

Nota: Los campos obligatorios aparecen indicados con un
asterisco blanco (*).

Los campos obligatorios y predeterminados son: Patient Name
(Nombre del paciente), Patient ID (ID del paciente), Accession
Number (Nimero de ingreso) y Laterality (Lateralidad).

e Introduzca todos los campos obligatorios. Si falta algin campo obligatorio, el botdn
Accept (Aceptar) no estara activo. El usuario podré completar otros campos si lo desea.

Nota: La fecha de nacimiento debera introducirse como aaaa/mm/dd (por ejemplo, 1962/08/13).

e Para activar la obtencion de imagenes, seleccione Accept (Aceptar).

Obtencion de imagenes de rayos X

Coloque los especimenes en un recipiente para especimenes proporcionado por Hologic,
Inc. o su institucion, y pongalo dentro del compartimento de rayos X Path. El area de
obtencién de imagenes esta marcada con una banda adhesiva del contorno. (El usuario
también puede colocar el espécimen y el recipiente en la bandeja de aumento suministrada
con el sistema Path).

Pulse el botdn verde Start X-ray (Comenzar radiografia) del software o de la parte frontal
del armario de rayos X para iniciar la obtencién de imagenes o radiografias.

Espere a que se visualice la imagen.

Nota: Si el modo Full Auto (Totalmente automatico) esta seleccionado, se realizaran dos
radiografias; la primera, para determinar los mejores ajustes, y la segunda para obtener la
imagen. Los ajustes utilizados durante la exposicion (kV y tiempo) se mostraran en la
pantalla LCD de los armarios.

4.2.0 Cont.

Figura 4.1.5

Pantalla Patient Data (Datos

del paciente)
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Faxitron" Path SECCION

Sistema de radiografia de muestras Inicio répido
El software Vision esta configurado para guardar automaticamente la imagen en la base de 4.2.0 Cont.
datos de Faxitron, en la unidad local del ordenador del sistema. El usuario también puede
guardar la imagen en el servidor de instalaciones haciendo clic en el icono PACS (SACI).
Véase la Figura 4.1.6.
Figura 4.1.6

Faxitron

Pantalla de la imagen

Para obtener mas informacion sobre cémo ajustar la configuracion de las imagenes, los
controles de rayos X'y las opciones de revision y guardado, consulte la Seccion 5.
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Faxitron® Path SECCION 5

Software
Sistema de radiografia de muestras VISION

SECCION 5
Funcionamiento del
software VISION
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Faxitron" Path

Sistema de radiografia de muestras

SECCION

Software
VISION

El software Vision es un completo paquete de obtencion y procesamiento de imagenes que
estéa disefiado exclusivamente para trabajar con los generadores de rayos X de Faxitron (como
los sistemas VersaVision, Faxitron Path, CoreVision y BioVision). Ademas de las funciones de
obtencidn y procesamiento, el software ofrece un amplio médulo de base de datos que permite
el control y el mantenimiento de archivos y el almacenamiento, la tramitacién y la recuperacion
de las imagenes por parte del usuario. El software también es compatible con Imagenologia
Digital y Comunicaciones en Medicina (DICOM), lo que permite guardar e imprimir imagenes
de los pacientes en formato DICOM 3.0. El software ha sido preinstalado en el ordenador que
se incluye con el sistema de rayos X.

Para obtener la mejor calidad de las imagenes, sera necesario calibrar el sistema cada nuevo
dia de uso. Para garantizar que la calidad de las imagenes sea 6ptima, el usuario del sistema
también podra realizar la calibracion en cualquier momento.

Después de la calibracion, se mostrara Menu de inicio, que permite navegar al resto de areas
del software. Para facilitar el uso, se proporcionan botones de aplicacion. Véase la Figura 5.0.1.
Estos botones estan en el centro de la pantalla. Las descripciones y definiciones de los botones
aparecen explicadas en las préximas secciones de este manual.

Start Procedure

>

Calibrate Review Shut Down

2007, 14:41:53 Tue

Protocolo de la secuencia

Para garantizar que la funcionalidad del sistema y la calidad de las imagenes sean las
adecuadas, debera seguirse esta secuencia de puesta en marcha:

Encienda el armario Faxitron Path mediante el interruptor situado en su parte posterior.
(El interruptor de alimentacion esta junto a la toma de corriente del cable de alimentacion).
Pulse «I» para kENCENDERLO» y «0» para «KAPAGARLO».

Encienda el armario Faxitron Path introduciendo la llave Faxitron Path en el interruptor de
cerradura con llave, situado en el panel frontal, y girandola en el sentido de las agujas del reloj
hasta la posicién de las tres. Nota: La llave no se puede extraer en esta posicion.

Encienda el ordenador y el monitor.

El software Vision se iniciara automaticamente cuando Windows haya
completado su secuencia de arranque. Aparecera brevemente un cuadro de
diadlogo para indicar que el software se ha inicializado y esta cargado. Nota:
Si Vision no se inicia automaticamente, haga doble clic con el botén
izquierdo del raton en el icono del software Vision (ubicado en el escritorio
de Windows). Véase la Figura 5.1.1.

El software Vision se abrirA en Home Menu (Menu de inicio) o en la pagina Calibration
(Calibracion), dependiendo del tiempo transcurrido desde la ultima calibracion del sistema.

Para obtener informacién sobre los protocolos de calibracion, consulte «Calibracion de la camara»
en la Seccion 3 y «Descripcion general de la calibracion de la camara», en la Seccién 5.2.1.

5.0.0
Descripcion
general del
software Vision

Figura 5.0.1
Home Menu (Menu de inicio) del
software Vision (pantalla de inicio)

5.1.0
Puesta en marcha
del software

VAN

Figura 5.1.1
Icono de escritorio del software
Vision
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Faxitron® Path SECCIoN

Software
Sistema de radiografia de muestras VISION
Introduccién a la calibracién 5.2.0
Descripcion

Para optimizar la calidad de las imagenes, el software Vision y el hardware requieren la I de |
realizacion periddica de la calibracion. Esta calibracién requiere la obtencion de imagenes de ger_‘era ) ,e a
referencia. calibracién de la

En el momento de la puesta en marcha inicial del sistema, o en cualquier momento deseado camara

por el usuario, se podra solicitar y realizar la calibracion del sistema. Se recomienda que,
transcurrido un periodo de doce (12) horas, se realicen las siguientes calibraciones.

Estas imagenes de calibracion de referencia se utilizan para calibrar, pixel por pixel, una
imagen de rayos X «sin procesar» con el fin de generar una imagen «corregida», que sera
visualizada. Las correcciones realizadas a la imagen abarcan correcciones de ganancia,
contraste y linealidad.

Secuencia de la calibracion

Para mayor comodidad, el software Vision combina los numerosos pasos de calibracién en un
solo paso unificado.

Cuando un sistema Faxitron de rayos X ha estado apagado durante mas de doce (12) horas,
el sistema solicitarda automaticamente que se vuelva a calibrar. Se recomienda
encarecidamente que el sistema se vuelva a calibrar tras periodos prolongados de inactividad
o después de que el sistema se traslade de una estancia a otra que tenga unos parametros de
temperatura o humedad ambiente potencialmente diferentes.

Para calibrar el sistema en cualquier momento, haga clic en el botdn Flggra 5'2.'1 L
Calibrate (Calibrar) en Home Menu (Start-up Screen) (Menu de inicio Boton Calibrar del menii de inicio
[Pantalla de puesta en marcha]) de Vision y, a continuacion, presione

Start Calibration (Iniciar calibracion). Véanse las Figuras 5.2.1y 5.2.2.
Durante la calibracion, el didlogo mostrara un mensaje de estado.
Véase la Figura 5.2.3. Calibrate

2007/07/31 14:41:53 Tue

Figura 5.2.2

Botén Start Calibration para
iniciar la calibracién

Start Calibration

Last Calibrated: 20f 31 14:41:53 Tue

Calibration before beginning any procedure is recommended

Figura 5.2.3

Calibrating

‘5‘ SYSTEM IN CALIBRATION

Durante la calibracién, puede que se generen rayos X. Durante la generacion de rayos X, se
hara visible el boton Stop X-Ray (Detener rayos X) para permitir que el usuario tenga la opcion
de detener los rayos X utilizando el software.
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Faxitron" Path

Sistema de radiografia de muestras

Software
VISION

Periédicamente, convendria incorporar las caracteristicas de atenuacion de los rayos X de un
atenuador uniforme en las imagenes de calibracion de referencia de campo plano. Por ejemplo,
si todos los objetos radiografiados se colocan sobre una placa plastica delgada, las
caracteristicas de atenuacién de los rayos X de la placa se observaran en cada imagen
obtenida. En este caso, la colocacién de la placa dentro del haz de rayos X durante la obtencion
de la imagen de calibraciéon de referencia de campo plano podria mejorar la calidad de las
imagenes. A continuacion se presenta un resumen del protocolo de calibraciéon avanzada para
«ambos» (el campo plano y la imagen):

Coloque el atenuador uniforme sobre el sensor. Toda la superficie del sensor debera estar
cubierta por el atenuador. Para obtener resultados ideales, el atenuador debera ser mayor que
el area de obtencion de imagenes del sensor.

Para enfocar el menu, desde la pantalla de puesta en marcha del software de obtencién de imagenes,

presione el icono A situado en la parte superior derecha. En el menu horizontal situado en la parte
superior de la pantalla, seleccione el elemento «Tools» (Herramientas) del menu desplegable y, a
continuacion, vaya hasta «Advanced Tools» (Herramientas avanzadas) y, después, a «X-Ray
Calibration/Exposure Setup» (Calibracion de rayos X/Configuracion de la exposicion).

¥-ray Generator and Exposure Settings 6

~ GEMERATOR SETTINGS — - E<POSURE SETTINGS

K Current SET SetFor  (O¥eay Cal (FlatField) (O Manuallmage @ Bath

User Time/ADU Target

Test Exposure ————————
mé Current 1000 ?
2.00 ‘ Select O Time @ADL ‘

Time []

; 280 .
ki srap Cal Pl | Time [s] |4_?5 | ADI |snuu.n |
:{n\-..fag: e Acquire E stimate/Calculate

AUTOMATIC EXPOSURE COMTROL [OM THE FLY]

tagrification -| 000
_AEC Mode for Image ON [TARGE T =Image 0L

- NUMBER OF CAL IMAGES —————— | AEC Mode for Flat-Field DN [TARGET =Flat-Field 4D U]
#-ray Cal [Flat-Field) Averages
v Al ] & TEHIEET willEE reashed By EEsitaut e carstraiit
— IMAGING MODE

E.&ppl}l tManual Imaging Settings On Exit, Disengage Preshot

[ Accept Settings ] [ Cancel ]

Nota: Los valores de kV, el tiempo de exposicion y las unidades analdgico-
digitales (UAD) podrian ser diferentes de los mostrados.

e En «X-Ray Generator and Exposure Settings» (Ajustes del generador de rayos X y la
exposicion), introduzca el ajuste de kV del generador en el campo correspondiente.

¢ Ajuste la «Magnification» (Ampliacion) o deje el uno (1.0) como ajuste predeterminado.
¢ En el cuadro de dialogo, seleccione el botén «Set for» (Ajustar para) «Both» (Ambos).

e En «user ADU target» (blanco de las UAD del usuario), deje el ajuste predeterminado. La
exposicion a los rayos X se interrumpira cuando el sensor haya acumulado un nivel medio de
sefal de UAD que sea aceptable para el generador de rayos X que usted tiene.

¢ Deje el tiempo de exposicion predeterminado de la prueba y haga clic en el botén Acquire
(Obtener). El sistema dara inicio automaticamente a los rayos X y obtendra una imagen.

e Cuando la exposicion a los rayos X haya finalizado, haga clic en el botéon Estimate/Calculate
(Estimar/Calcular).

¢ Registre la lectura del tiempo de exposicion «Time[s]» (Tiempo[s]) calculado. El sistema
calculara este tiempo y el numero aparecera en gris.

Calibracion
avanzada

Figura 5.2.4
Generador de rayos X y cuadro
de dialogo de la exposicion
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ION
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VISION

e Introduzca la lectura del tiempo de exposicion «Time[s]» (Tiempo[s]) calculado en la casilla
de tiempo «Test Exposure» (Exposicion de prueba). Para dar inicio automaticamente a los
rayos X y obtener una imagen, presione el botén Acquire (Obtener).

¢ Cuando la exposicion a los rayos X haya finalizado, haga clic en el boton Estimate/Calculate
(Estimar/Calcular).

* Registre la lectura del tiempo de exposicién «Time[s]» (Tiempo[s]) calculado.

¢ Vuelva a introducir la lectura del tiempo de exposicién calculado en la casilla de tiempo «Test
Exposure» (Exposicidon de prueba).

¢ Haga clic en el botdn Accept Settings (Aceptar configuracion).

¢ Realice un procedimiento estdndar de calibracion, tal y como se describe en la seccion
«Descripcion general de la calibracion de la camaray.

Como se describio anteriormente, puede que los usuarios experimentados quieran ajustar «X-
Ray Cal (Flat-Field)» (Calibracion de rayos X [Campo plano]) y «Manual Image» «Exposure
Settings» (Imagen manual) (Ajustes de la exposicién) por separado o «Both» (Ambos) (el
campo plano y la imagen manual). Seleccionando el botén de opcidn «Flat Field» (Campo
plano), el sistema determinara el tiempo de exposicion optimo para obtener imagenes de
campo plano al nivel de UAD deseado. Por consiguiente, la seleccion de «Manual Image»
(Imagen manual) determinara el tiempo de exposicién 6ptimo para el sistema con un objeto
que atenue la sefial de rayos X. Para obtener los mejores resultados, el objeto debera cubrir
toda el area de obtencién de imagenes del sensor.

Después de seleccionar «X-Ray Cal (Flat-Field)» (Calibracion de rayos X [Campo plano]) y
«Manual Image» (Imagen manual) y de haber ajustado el nivel de UAD, seleccione el boton
Acquire (Obtener). Para seleccionar «Manual Image» (Imagen manual), conviene tener el
objeto o el atenuador de rayos X en el haz de rayos X. Para generar rayos X y obtener una
imagen, pulse el botdon Acquire (Obtener). Cuando la exposicién a los rayos X haya finalizado,
haga clic en el botén Estimate/Calculate (Estimar/Calcular). El sistema calculara el tiempo
optimo, y el nimero aparecera en gris. Para guardar los «Exposure Settings» (Ajustes de
exposicién) en el archivo de configuracion del sistema, haga clic en el boton Accept Setting
(Aceptar ajuste). Nota: Solamente se guardaran los ajustes del boton de opcion que haya
seleccionado. A continuacion, realice un procedimiento estandar de calibracion, tal y como se
describe en la seccién «Descripcion general de la calibracidon de la camara».

El botén Start Procedure (Iniciar procedimiento,; véase la Figura 5.0.1) lleva al usuario a la
pagina Patient Data Entry (Introduccion de datos del paciente), que proporciona métodos para
introducir los datos de los pacientes. Si no se ha configurado una lista de trabajo, la opcion
aparecera en gris y solamente se podra acceder a las opciones Continue with Current Patient
(Continuar con el paciente actual), Manual Entry (Introduccion manual) y Select from
Database (Seleccionar en la base de datos). Las opciones aparecen explicadas en las
siguientes secciones.

Select from Work List

>

Continue with Current Patient Rl o B e lEes E
JANE DOE

5.2.1 Cont.

5.3.0

Datos del paciente

Figura 5.3.1

Pantalla Introduccion de datos del

paciente
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Faxitron® Path Shecion

Software
Sistema de radiografia de muestras VISION
SELECCIONAR EN LA LISTA DE TRABAJO 5.3.1
(Lista de trabajo de modalidad remota) Seleccionar en la

Si se ha configurado una lista de trabajo, el usuario podra hacer clic en el botén Select from lista de trabajo
Work List (Seleccionar en la lista de trabajo), que mostrara la siguiente pagina. Véase la
Figura 5.3.2 a continuacion.

e PArRatie e R vy e Figura 5.3.2

S : il v e s T e Bl s . on e Diélogo de busqueda en la lista

oo i s w ; I de trabajo de la modalidad

Birtn Date

Proc. Start Date 2019/03/28

Accession No.

FAXITRON_DR

Nota: Todos los datos de los
pacientes son ficticios.

Cualquier parecido con personas

reales es pura coincidencia.

A la izquierda hay varios filtros que pueden utilizarse para buscar procedimientos programados
para la aplicacion de la terminal (AE). Verifique que esté definido el titulo AE de la terminal; a
continuacién, cualquier campo individual o cualquier combinacién de campos podra utilizarse
como filtro para buscar procedimientos programados para este AE. Seleccionando el botén
Query (Consulta) situado en la esquina inferior izquierda, la tabla se rellenara con las entradas
que coincidan con la informacién consultada.

El usuario podra entonces hacer clic en cualquier entrada y pulsar Submit (Enviar) para rellenar
automaticamente el editor de la informacion sobre la obtencion de imagenes con la informacion
del paciente.

AVISO: El usuario también podré hacer doble clic en cualquier entrada de la tabla para acceder
rapidamente al editor de la informacién sobre la obtencion de imagenes sin tener que presionar
Submit (Enviar).

Se abrira el editor de la informacion sobre la obtencion de imagenes Patient Information Dialog
(Dialogo de informacion sobre el paciente). Véase la Figura 5.3.3. Para proceder a la obtencion
de imagenes, rellene el resto de los campos obligatorios y haga clic en Accept (Aceptar).
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Faxitron® Path

Sistema de radiografia de muestras

SECCION

Software
VISION

Nota: Los campos obligatorios aparecen indicados con un asterisco blanco (*). Los campos
obligatorios y predeterminados son: Patient Name (Nombre del paciente), Patient ID (ID del

paciente), Accession Number (Numero de
ingreso) y Laterality (Lateralidad).

Antes de poder seleccionar el boton Accept
(Aceptar), el usuario debera introducir todos los
campos obligatorios. Si asi lo desea, el usuario
también podra introducir los campos Date
(Fecha), Referring Physician (Médico remitente),
Procedure Name (Nombre del procedimiento),
Sex (Sexo), Technician (Técnico), Position View
(Vista de la posicién), Body Part (Parte
anatomica) y Study ID (ldentificacion del
estudio). EI nombre del procedimiento, la vista de
la posicion y la parte anatdomica se eligen
mediante un menu desplegable.

Nota: La fecha debera indicarse como
aaaa/mm/dd (por ejemplo, 1962/08/13).
Si no se introduce la fecha valida, se
podran producir errores al intentar
recuperar las imagenes.

Nota: En funcién de la aplicacién, «los campos
obligatorios» pueden ser modificados o
eliminados. Pdngase en contacto con el
servicio de asistencia técnica de Hologic
para obtener mas informacion.

Para regresar a la pagina de introduccion de
datos de los pacientes, seleccione Accept
(Aceptar) para continuar o Start a New Patient
or Procedure (lniciar un paciente o
procedimiento nuevo).

Patient Name:

Patient ID:

Accession #:

Date of Birth:

Sex:

Procedure Name:

Laterality:
Position View:
Body Part:
Refer. Physician:
Technician:

Technician |D:

Study Name:

Study ID:

L. Jane
LN JD4567
N 918273

1920/03/20

*

=
AV 4 O«

Start a New Patient or Procedure

Continuar con el paciente actual

Haga clic en el boton Continue with Current Patient para continuar con el procedimiento del

paciente actual. Se abrira «Image Information Editor» (Editor de la informacion de las
imagenes). Véase la Figura 5.3.3. Siga el procedimiento y las notas anteriores.

Introduccién manual

Haga clic en el botéon Manual Entry para introducir manualmente un nuevo procedimiento. Se
abrira el editor de la informacién sobre la obtencion de imagenes. Véase la Figura 5.3.3. Siga

el procedimiento y las notas anteriores.

5.3.1 Cont.

Figura 5.3.3
Editor de la informacién sobre la
obtencién de imagenes

5.3.2
Continuar con el
paciente actual

5.3.3
Introduccion
manual
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Faxitron® Path Shecion

Software
Sistema de radiografia de muestras VISION
Seleccionar en la base de datos 5.34

Seleccionar en la

Si selecciona el botén Select from Database (Seleccionar en la base de datos), aparecera la base de datos

siguiente pagina. Véase la Figura 5.3.4 a continuacion.

Patient D M L

Search Parameters: 00004 0320-5906 HOUSTON CARLA 2018/04/17 17:35... 1732/04/31 F Figura 5.3,4

atient 10 oo} pimerl, | sy pam st Seleccion de pacientes en las

A 00002 AvaS672 GARCIA MARIA 1678/03/04 F entradas de la base de datos
00003 AvI5673 SMITH MARY 1678/03/04 F

Frst Norne local

Middle Name
Time Modified

Date of Birth

Nota: Todos los datos de los
pacientes son ficticios.

Cualquier parecido con personas
reales es pura coincidencia.

I é‘

El usuario selecciona a un paciente en la tabla situada en el lado derecho de la paginay,

a continuacién, hace clic en el boton Accept (Aceptar), que abre el editor de la informacion
sobre las imagenes. (Nota: Para abrir el editor de informacién sobre las imagenes, el usuario
también puede hacer doble clic en la entrada de la tabla). A continuacion, siga el
procedimiento y las notas de la pagina 5.7.

Nota: Para ver la informacion oculta de los pacientes, utilice la barra de desplazamiento
situada en la parte inferior de la pantalla.

Vision permite al usuario reducir la lista de pacientes introduciendo informacion especifica en
la ventana «Search Parameters» (Parametros de busqueda) situada en el lado izquierdo de
la pagina. Solamente se mostraran aquellos pacientes que coincidan con todos los
parametros de busqueda.

HOLOGIC

MANUAL DE USUARIO DE FAXITRON PATH | HOLOGIC | REVISION 002 5-8




Faxitron® Path

SECCION

Software
Sistema de radiografia de muestras VISION
Si el usuario desea cambiar o ver la informacion después de haberla introducido 5.3.5
pero antes de haber tomado una imagen, podra pulsar en el icono Patient Data %
(Datos del paciente) situado en la esquina superior izquierda. Véase la % '°°’]° de datos del
Figura 5.3.5. paciente
Figura 5.3.5
Se abrira la ventana de edicion de la informacion sobre el paciente o sobre la obtencién de  Datos del paciente
imagenes. Esta ventana de edicién se rellenara con toda la informacién que se haya introducido
o seleccionado previamente. Véase la Figura 5.3.6. Nota: La ventana de edicion incluird ahora
el botén Cancel (Cancelar).
El usuario podra cambiar o afadir la Figura 5.3.6

informacion que desee y luego hacer clic en:

Una vez que el usuario haga clic en el botén Accept (Aceptar), el sistema estara listo para

el boton Accept (Aceptar) para guardar los
cambios y continuar con la obtencion de
imagenes;

el boton Cancel (Cancelar) para cancelar los
cambios y continuar con la obtencion de
imagenes. El software volvera a la
informacion original sobre el paciente que se
haya introducido, o

el botén Start a New Patient or Procedure
(Iniciar un paciente o procedimiento nuevo),
que devolvera al usuario a la pantalla de
introduccion de datos del paciente. Véase la
Figura 5.3.1.

obtener imagenes o radiografias.

Las radiografias se inician presionando el botén verde Start (Comenzar) en la parte frontal del
armario Faxitron Path o haciendo clic en el botén Start X-Ray (Comenzar radiografia) situado
en la esquina inferior derecha de la pantalla. Véase la Seccion 4.2.0, Obtencién de imagenes.
El sistema tomara una breve radiografia «de muestra», o una toma previa (que se explica en
la Seccion 5.4.4), seguida de una exposicion mas prolongada para obtener la imagen. El
software procesara la imagen antes de que se muestre en la pantalla del monitor. Una vez se
muestre la imagen, se activaran los botones situados en los lados izquierdo y derecho de la

pantalla, tratados en toda esta seccién.

Patient Name:

Patient ID:

Accession #:

Date of Birth:

Sex:

Procedure Name:

Laterality:
Position View:
Body Part:
Refer. Physician:
Technician:

Technician ID:

Study Name:

Study ID:

*

L JD4567
£ N 918273

1920/03/20

*

s
s
T
Fomae ¢
I
—
—
(I —
I —
——
T
I—

>

Start a New Patient or Procedure

Diédlogo de Datos del paciente
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Faxitron" Path

SECCION

Software
Sistema de radiografia de muestras VISION
5.3.5 Cont.
pateni ame: . FESTR  CETN
Patient ID: L Jpass7 Figura 5.3.7

Después de obtener una imagen, el usuario podra
ver, pero no editar, la informaciéon del paciente
haciendo clic en el icono Patient Data (Datos del
paciente) que se muestra en la Figura 5.3.5. Esto
mostrara un cuadro de dialogo modificado Patient
Information (Informacion sobre el paciente), como se
muestra en la Figura 5.3.7. Dicho cuadro incluye dos
botones: Close Dialog (Cerrar dialogo) o Start a
New Patient or Procedure (Iniciar un nuevo
paciente o procedimiento).

Una vez tomada la imagen, se podran ver las propiedades de la imagen actual
pulsando el icono (i) situado en la esquina superior derecha. Véase la Figura 5.3.8.
Aparecera el cuadro de didlogo Image Properties (Propiedades de la imagen) en la
esquina superior derecha de la imagen. El cuadro es semitransparente para

Accession #:

Date of Birth:

Sex:

Frocedure Name:

Laterality:

Position View:
Body Part:
Refer. Physician:
Technician:

Techniclan |10:

Study Name:
Study 1D:
|

Close Dialog

<

*

918273

1920/03/20

Start 2 New Patient or Procedure

permitirle a uno ver lo que hay por debajo del cuadro. Véase la Figura 5.3.9.

1.000% 2017/08/14 16:12:18 Monday

ZB.0kV, 1.00 mA, 3.73 mAs, 3.735,

120170814161218.dom

C:'Bioptics\Data\

Faxitron Bioptics

Diélogo de informacién sobre el
paciente tras obtener las
imagenes

Figura 5.3.8
Icono de propiedades de la
imagen

Figura 5.3.9
Dialogo de propiedades de la
imagen (solo lectura)
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Faxitron’ Path Sottunne

Sistema de radiografia de muestras VISION

El software Vision proporciona varias herramientas y menus para controlar varios atributos o
parametros de las imagenes, la obtencion de rayos X, las vistas de imagen, las herramientas Barra de
de imagen y los ajustes o accesos de DICOM. Las herramientas mas utilizadas estén situadas .

en una barra de herramientas. La barra de herramientas y los menus se describen con mas herramientas
detalle en las proximas paginas. y menus

Con un solo clic, el software Vision permite acceder a una serie de herramientas o funciones de

uso comun con una barra de herramientas vertical ubicada en el lado izquierdo de la pantalla. En Barra de

las paginas siguientes se ofrecen descripciones mas detalladas. Véase la Figura 5.4.1. .
herramientas

lateral

Ver o modificar la informacién sobre  NOTAS:
el paciente
(Véase la Seccion 6.3.5 y Figura 6.3.5) | as siguientes herramientas estan
siempre activas en la pagina de
Icono de mejora de la imagen obtencién de imagenes:
o Ver o modificar la informacion
sobre el paciente
e Control de la exposicion
Herramienta Nivel de la ventana e Volver al menu principal
y contraste o Apagado del sistema

Figura 5.4.1
Barra de herramientas lateral

Las siguientes herramientas se

Herramienta Zoom digital desactivaran después de introducir
los datos del paciente y solamente se
activaran tras obtener una radiografia:
e Mejorar la imagen

Herramientas de anotacion o Nivel y contraste de la ventana
e Zoom digital
¢ Anotacion

PACS Save (Guardar en SACI) Las herramientas PACS Save

(Guardar en SACI) y PACS Print

(Impresion en SACI) solamente se

activaran después de realizar una

radiografia y cuando el sistema esté
PACS Print (Impresién en SACI) conectado a una red SACI.

Control de la exposicion (Panel de control del dispositivo)

Volver al menu principal

Apagado del sistema

HOLOGIC
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Faxitron" Path

Software
Sistema de radiografia de muestras VISION
Mejorar imagen
El boton mostrado en la Figura 5.4.2 procesara la imagen en la pantalla para destacar en ella
los detalles mas pequefios, como las microcalcificaciones y las pequefias masas. Figura 5.4.2

/4(

En la obtencion de imagenes avanzadas, el algoritmo comunmente denominado «ecualizacién
periférica» o «ecualizacion del espesor» se aplica a toda la imagen. Ademas de este algoritmo,
Hologic emplea un segundo algoritmo desarrollado internamente y llamado «énfasis de las
calcificaciones». Este algoritmo secundario fue creado para resaltar pequefios detalles de la
imagen y hacerlos mucho mas faciles de ver y analizar.

Dado que las imagenes de los pacientes constituyen una categoria mas general en cuanto a
las posibles geometrias y la variedad de espesores, puede que haya geometrias de las
muestras que representen un reto, y el usuario debera utilizar esta herramienta con cuidado.

El sistema estara inactivo (en espera) durante el proceso. Una vez finalizado, el botdn
permanecera pulsado o activo. El usuario podra deshacer el proceso pulsando de nuevo el
botén.

Icono de mejora de la imagen
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Faxitron® Path Shecion

Software
Sistema de radiografia de muestras VISION
Ajuste de la inversidn, el nivel de la ventana y el contraste 5.4.1 Cont.
El boton, mostrado en la Figura 5.4.3, abrira la herramienta de ajuste Window Level and
Contrast (Nivel de la ventana y contraste). Esta herramienta permite al usuario ajustar el nivel
de la ventana y el contraste de la imagen. El usuario también podra restaurar el contraste
original pulsando el botén Original Contrast (Contraste original) o invertir la imagen pulsando
el boton Invert (Invertir). La inversién cambia el esquema croméatico de ser predominantemente
negro a ser predominantemente blanco, y viceversa. Véase la Figura 5.4.4 siguiente.
Figura 5.4.3
Icono y controles de la
herramienta Nivel de la ventana y
contraste
El usuario también podra ajustar el contraste
deseado de la imagen haciendo clic en la barra
deslizante y moviéndola hacia arriba y hacia abajo o
haciendo clic en las flechas que correspondan de la E3
barra para mover los limites inferior o superior del
nivel de la ventana. Véase la Figura 5.4.3
(informalmente, esto también se denomina
«Equilibrado de la ventana»).
Original Contrast
Invert
A continuacion se muestra el ejemplo de una
Figura 5.4.4

Ejemplo de inversion con la
herramienta Ajuste del contraste
y Nivel de la ventana

inversion:
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Faxitron" Path

Sistema de radiografia de muestras

Software
VISION

Ajuste del zoom dinamico

El icono de la herramienta de zoom, Figura 5.4.5, abrira la herramienta de ajuste del zoom.
Después de abrir esta herramienta, el usuario podra utilizar la barra deslizante para ajustar el
nivel del zoom o hacer clic en los botones Fit to Specimen (Ajustar al espécimen), Fit to
Screen (Ajustar a la pantalla) o Zoom 1.0x (resolucién completa). Véase la Figura 5.4.6. Para
navegar por toda la imagen, cuando esta haya sido ampliada, sera necesario realizar una
panoramica. Aparecera un cuadro de dialogo en miniatura en la esquina superior izquierda de
la pantalla. Véase la Figura 5.4.7 a continuacién. Para mover la imagen en la pantalla principal,
haga clic y mantenga presionado el botén izquierdo sobre la imagen, y mueva el ratén.

Tenga en cuenta que, tradicionalmente, esta funcién también se denomina «Vista panoramica»
o «Pan and Scan».

ZOOM LEVEL *
—  3.00x
—  1.00x
—  010x
Para asegurarse de que el espécimen esté a la vista, el botén 0.44
Fit to Specimen (Ajustar al espécimen) intentara detectar y | ———
ampliar el espécimen. Si no se detecta un espécimen, este se
ajustara por defecto al modo anterior (ya sea «Fit to Screen»
[Ajustar a la pantalla] o «Zoom 1.0x»). | |
Fit to Screen (Ajustar a la pantalla) ajustara la imagen a la
[
pantalla.
Tradicionalmente, Zoom 1.0x se denomina «resolucion
completa», ya que lleva la imagen a una vista 1-1 con la
resolucién del monitor. Cancel oK

Figura 5.4.5
Icono de la herramienta Zoom

Figura 5.4.6
Herramienta de ajuste del nivel
de zoom

Figura 5.4.7
Ejemplo de vista panoramica
(izquierda)
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Faxitron® Path Shecion

Software
Sistema de radiografia de muestras VISION
Anotacion 5.4.1 Cont.
El botdon mostrado en la Figura 5.4.8 abrira las herramientas de anotacion. Estas Figura 5.4.8

herramientas y sus numerosas funciones se tratan con mas detalle en la Seccién 5.8.0. Jcono de Anotaciones

Almacenar en SACI

Figura 5.4.9

El botdn mostrado en la Figura 5.4.9 solamente funcionara cuando el sistema esté
Icono de Guardar en SACI

instalado en un centro médico con una red SACI. Para guardar sus archivos
localmente, consulte la seccién 5.7.0.

0

Impresion en SACI

El botén mostrado en la Figura 5.4.10 solamente funcionara cuando el sistema esté Figura 5.4.10 .
. o . . Icono de Impresion en
instalado en un centro médico con una red SACI. Para efectuar la impresion local, % SACI
consulte la seccion 5.7.0.
Panel de control del dispositivo
El boton mostrado en la Figura 5.4.11 abrira el panel de control del dispositivo, lo Figura 5.4.11

que ofrecera al usuario del dispositivo la oportunidad de controlar el sistema de Icono de Volver al procedimiento
rayos X mediante el software. El usuario podra seleccionar faciimente el modo de
exposicion, el ajuste de kV del tubo de rayos X, el tiempo de exposicién y el niumero
de imagenes que deberan obtenerse para el promediado de las imagenes (si lo

desea), asi como iniciar la exposicion a los rayos X.

Figura 5.4.12

Nota: El estado o la disponibilidad de los ajustes Panel de control del dispositivo

de la exposicidon se indica mediante las flechas
arriba y abajo adyacentes al ajuste. Las flechas @ Full Auto O Auto kV
seran blancas para los ajustes activos y celestes
para los inactivos. Los ajustes de la exposicion que
estén activos dependeran del modo de exposicion
seleccionado.

(O Auto Time O Full Manual

La Figura 5.4.12 de la derecha muestra que se ha
seleccionado el modo Full Auto (Totalmente
automatico) y que los promedios de kV, tiempo e 26
imagen estan todos activos. El usuario podra

ajustar cada una de estas configuraciones.

Tenga en cuenta que, en el sistema Faxitron Path, 3 - O 0 TIEIEHE)
la configuracién de mA no se puede ajustar

utilizando el software. La configuracion de mA se O 40

mostrara como inactiva. .

Cuando termine, haga clic en el boton Request
X-Rays (Solicitar rayos X) para adquirir una
imagen o en el botén Set (Ajustar) para guardar la Image Averages LV
configuracion y cerrar el panel de control del
dispositivo.

N

Request X-Rays

Si se hace clic en el boton Cancel (Cancelar), el
panel de control del dispositivo se cerrara sin

guardar ninguno de los cambios. < Cancel
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Faxitron" Path

Software
Sistema de radiografia de muestras VISION
Volver al procedimiento
El boton mostrado en la Figura 5.4.13 cierra el modo de obtencion de imagenes y .
regresa a la pantalla del Home Menu (Menu de inicio). Figura 5.4.13

O

Apagado

El botén mostrado en la Figura 5.4.14 cierra el software y apaga el sistema.

Notas de dialogo adicionales

Cuando se abre un dialogo, este se «acopla» a la izquierda de la pantalla. Si un usuario desea
desacoplar el cuadro de dialogo, podra hacer clic en el icono de «anclaje» superior derecho
para desacoplar el cuadro de dialogo y poder arrastrarlo libremente. El «anclaje» se convertira
luego en un icono «X», que permitira el cierre rapido.

Los usuarios también pueden navegar rapidamente entre los distintos didlogos haciendo clic
en el menu de la izquierda. Al hacerlo, el menu de la izquierda se cerrara rapidamente y abrira
los cuadros de dialogo correspondientes, segun sea necesario.

Barra de menu superior

El software permite acceder a los menus «View» (Ver), «Tools» (Herramientas), «Image Tools»
(Herramientas de imagen), «DICOM Utilities» (Utilidades de DICOM) y «Help» (Ayuda)
mediante una barra de menu superior. Véase la Figura 5.4.15. La barra de menu superior esta
oculta de forma predeterminada y se muestra haciendo clic en el botén de flecha ubicado en
la esquina superior derecha de la pantalla. Véase la Figura 5.4.16. El boton de flecha sera
blanco o negro, dependiendo de la pagina del software o el fondo de pantalla. Cada elemento
del menu se tratara en detalle en las paginas siguientes.

File Edit View Tools Image Tools DICOM Utilities Help

v M

El menu «Ver» se encuentra en el menu principal superior y contiene los elementos del
submenu mostrados en la Figura 5.4.17 siguiente. Cada elemento del submenu se describira
con mas detalle en las proximas péaginas.

Nota: La flecha apuntara hacia abajo cuando la barra de menu superior
esté oculta, y hacia arriba cuando esta se muestre.

Menu Ver

mTools Image Tools  DICOM Utilities  Help

Zoom Mode b MNORMAL (FULL RES.)
Image Averages ADJUST ZOOM
Image Perspective FIT TO SAMPLE

Grid Options v | FTALL

User Window Levels FIT WIDTH

Default Window Level FIT HEIGHT

Default Aspect for Raw Files
| Enhanced Image
Sample Viewer

Magnifier Size

* v ¥ v v v wv v wv v

Review Layout

Icono de regreso al ment de
inicio

Figura 5.4.14
Icono de apagado del sistema

Barra de menu
superior

Figura 5.4.15
Barra de menu superior

Figura 5.4.16
Botones de la barra de ment
superior

Menu Ver

Figura 5.4.17
Mend Ver
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Faxitron® Path Shecion

Software
Sistema de radiografia de muestras VISION
Modo Zoom 5.4.3 Cont.
Normal

Muestra la imagen obtenida en su formato original. La imagen de los sistemas Faxitron Path
supera el area de visualizacion de los monitores. En la esquina superior izquierda de la imagen
se mostrara un cuadro de didlogo en miniatura que permitira al usuario «panoramizar» la
imagen. Consulte Ajuste del zoom dinamico en la Seccion 5.4.1.

Adjust Zoom (Ajustar el zoom)

Esta opcion esta desactivada y no esta disponible en este momento.

Fit to Sample (Ajustar al espécimen)

Esta opcion adapta la imagen obtenida para que se ajuste mejor a la muestra de especimenes
dentro del area de visualizacion del monitor.

Fit All (Ajustar todos)

Esta opcidon muestra toda la imagen obtenida, independientemente de cual sea su formato
original. La opcion Full Resolution (Resolucion completa) no funciona en este modo de vista.

Fit Width (Ajustar anchura)

Esta opcion muestra la imagen obtenida a lo largo del ancho disponible de toda el area de
visualizacion.

Ajustar altura (Ajustar altura)

Esta opcién muestra la imagen obtenida a lo largo de la altura disponible de toda el area de
visualizacion.

Image Averages (Promedios entre las imagenes)

Esta opcion permite al usuario ajustar el nimero de promedios entre las imagenes que se
tomaran por cada exposicion. Las opciones disponibles son las tomas 1x, 2x, 4x u 8x. El ajuste
predeterminado es la toma 1x. Si el usuario selecciona 2, 4 u 8 tomas, el software obtendra el
numero de imagenes seleccionadas una detras de otra pulsando el botén Start (Comenzar)
una sola vez y promediara esas imagenes en una sola imagen.

Image Perspective (Perspectiva de la imagen)

Esta opcidon permite al usuario rotar la imagen visualizada a una orientacion de 0, 90, 180 y
270 grados.
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Sistema de radiografia de muestras VISION

Grid Options (Opciones de cuadricula)

Cuando se muestra una imagen, ya sea como una imagen obtenida o una imagen recuperada

de la base de datos, el usuario podra activar una cuadricula. También permite al usuario

establecer el espaciado (anchura) de la cuadricula. Véase el ejemplo siguiente.

: Figura 5.4.18

Visualizacion de la cuadricula de
la muestra

User Window Levels (Niveles de la ventana de usuario)

Esto permite al usuario definir hasta tres (3) niveles de la ventana (WL) prefijados y
establecidos por el usuario. En primer lugar, seleccione el botén Window Level (Nivel de la
ventana). Ajuste el WL al nivel deseado. En las herramientas «View» (Ver), seleccione «User
Window Levels» (Niveles de ventana de usuario). Seleccione «Record Current WL» (Registrar
WL actual) como USUARIO WL n.° 1, n.° 2 o n.° 3. EI WL ajustado se guardara segun la opcién
seleccionada previamente.

Default Window Level (Nivel predeterminado de la ventana)

El usuario tiene dos opciones de «Default Window Levels» (Niveles predeterminados de la
ventana) (WL): «Optimize for whole area» (Optimizar para toda el area), que ajusta el WL para
toda la imagen, u «Optimize for sample» (Optimizar para el espécimen), que ajusta el WL
solamente para el area del espécimen. Ademas, existe la opcion «Set Default Window Level»
(Establecer el nivel predeterminado de la ventana), que se utiliza también para todas las
imagenes obtenidas que se encuentran aqui. Esta establecera el nivel predeterminado de la
ventana en funcion de las estadisticas de la imagen, y debera hacerse por separado para las
imagenes no mejoradas y las mejoradas.

Default Aspect of Raw Files (Aspecto predeterminado de los
archivos sin procesar)

Esta herramienta se encuentra bajo el menu VIEW (Ver). Ayuda a importar y abrir archivos de
imagenes previamente guardados con atributos de archivo desconocidos o datos de imagenes
binarios que no tienen ninguna informacién de encabezado. Dado que el tamafio exacto del
conjunto del generador de imagenes no esta disponible en el encabezado del archivo de datos
de imagen, se usaran las dimensiones del generador de imagenes mas adecuadas para
importar o abrir dichas imagenes en funcién de que el ancho sea mayor o menor que la altura
(informacion de aspecto predeterminada).

Enhance Image (same as the Enhance Image button) (Mejorar la
imagen [igual que el boton Mejorar la imagen])

Procesa la imagen actual del paciente y mejora la visualizacion del tejido situado cerca de la
periferia de la muestra.
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Sample Viewer (Visor de muestras)

En el caso de que el sistema tenga una camara web, esta conmutara el visor de la camara web
del sistema para permitir la orientacién y alineacion de los especimenes.

Review Layout (Disposicion de la revisién)

Ayuda al usuario a configurar multiples paneles de imagen en Review (Database) Mode (Modo
de revision [de la base de datos]) del programa. Las opciones de disposicion disponibles son:
«(1 X 1) Single» (Simple), «(2 X 1) Double H» (Doble H), «(1 X 2) Double V» (Doble V), «(1 +
(2X 1) Triple» y «(2 X 2) Quadruple» (Cuadruple). Durante la operacion con paneles multiples, el
usuario puede hacer clic una vez en el panel o la imagen deseada para realizar la seleccion
actual; el panel seleccionado actual tendra un borde rectangular verde alrededor. Las imagenes
incluidas en la vista de lista de la base de datos o vista de miniaturas de la base de datos se
abriran en el panel seleccionado actual cuando se haga doble clic sobre ellas. El usuario también
podra abrir las imagenes en los paneles deseados directamente desde el menu contextual de las
vistas de la base de datos mencionada. Después de activar el menu contextual, el usuario podra
seleccionar en los paneles listados bajo OPEN TO— (ABRIR HACIA), que proporcionara los
paneles disponibles para abrir la imagen (izquierda, derecha, arriba, abajo, etc.).

Menu Tools (Herramientas)

El menu «Tools» (Herramientas) esta ubicado en la barra de menu superior, situada en la
esquina superior izquierda de la pantalla principal.

ImageToDIs DICOM Utilities Help

Preferences

Service Mode
Service Tools

Save Reference Files
Advanced Tools 4 AUTO SAVE ON/OFF 3
| EDGE SUPPRESSION 3
TILE SUPPRESSION 3
K-RAY Calibration/Exposure Setup
PRESHOT AEC Exposure Setup

IMAGE ENHANCEMENT Setup

Legin Utility

Cylic Automated Acquisitions

OTHER ADVANCED User Tools J

PROPERTIES

EDIT  CurrentImage Record
DELETE Current Image Record
ADD  Current Image Record

CAPTURE Screen Shot JPG/BMP |

Save/Stere current image 3

Print current image >

Preferences (Preferencias)

El menu «Preferences» (Preferencias) abre una utilidad de gestidon de la configuracion que
permite cambiar varias opciones o parametros.

Nota: La herramienta «Preferences» (Preferencias) esta protegida mediante contrasefia y
solamente puede acceder a ella un representante autorizado del servicio técnico de Hologic.

Nota: Cambiar los parametros de configuracion sin los conocimientos ni la autorizacion
pertinentes podra causar la pérdida de calidad de las imagenes, dafios en el sistema y
funcionamiento incorrecto del sistema.

Modo Service (Modo de mantenimiento)
El «Service Mode» (Modo de mantenimiento) esta protegido mediante contrasefa y lo activan
técnicos autorizados de Hologic para resolver problemas.
Service Tools (Herramientas de mantenimiento)

«Service Tools» (Herramientas de mantenimiento) suelen aparecer sombreadas en gris.
Solamente se enciende cuando el sistema esta en «Service Mode» (Modo de mantenimiento).

Menu Herramientas

Figura 5.4.19
Ment Herramientas
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Save Reference Files (Guardar archivos de referencia) 5.4.4 Cont.

La opcion «Save Reference Files» (Guardar archivos de referencia) suele aparecer
sombreada en gris. Solamente se enciende cuando el sistema esta en «Service Mode»
(Modo de mantenimiento).

Opcién Advanced Tools (Herramientas avanzadas)

Las «Advanced Tools» (Herramientas avanzadas) ofrecen varias opciones para configurar
aspectos del software tales como el post-procesamiento y las opciones de configuracion.

Auto Save On/Off (Guardar el encendido y apagado automatico)

Cuando «Auto save» (Guardar automaticamente) estd «activado», todas las imagenes
obtenidas posteriormente se guardaran en la base de datos. Los archivos se escribiran en un
directorio de datos definido en el archivo de configuracion.

X-Ray Calibration/Exposure Set-up (Calibracién de los rayos
X/Configuracién de la exposicién)

Se encuentran en Advanced Tools (Herramientas avanzadas). «X-Ray Calibration/Exposure
Setup» (Calibracién de los rayos X/Configuracion de la exposicion) ayuda al usuario a
determinar el tiempo de exposicién adecuado para un determinado ajuste de kV que obtenga
la mejor calidad de las imagenes. Consulte en la seccion 5.2.0 y la Figura 5.2.1 una descripcion
mas detallada.

Configuracion del CAE de la exposiciéon de una toma previa

El sistema Faxitron Path utiliza el control automatico de la exposicion (CAE) para proporcionar
la mejor calidad posible de las imagenes pulsando el boton Start X-Ray (Comenzar radiografia)
una sola vez. El software utilizara una exposicién de una Preshot (Toma previa) para calcular
los ajustes 6ptimos de la exposicion en kV y tiempo. La toma previa es una exposiciéon breve a
los rayos X, normalmente de 2 a 3 segundos. El software analizara los resultados para
determinar los kV y el tiempo necesarios para producir la mejor calidad de las imagenes. La
exposicion al CAE de una toma previa se configura en fabrica y se activa de forma
predeterminada.

«Preshot AEC Exposure Setup» (Configuracion del CAE de la exposicidén de una toma previa)
permite al usuario ajustar el sistema a determinados requisitos de obtencién de imagenes o
para compensar el envejecimiento del sistema.

Para acceder al cuadro de didlogo «Preshot AEC Exposure Setup» (Configuracion del CAE de
la exposicion de una toma previa), vaya a la barra de menu superior, seleccione «Tools»
(Herramientas), «Advanced Tools» (Herramientas avanzadas) y, a continuacion, «PRESHOT
AEC Exposure Setup» (Configuracion del CAE de la exposicidon de una toma previa). Véase la
Figura 5.4.19.
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Introduzca los valores de PRESHOT
AEC (CAE DE LA TOMA PREVIA)
FRESHOT - 4EC ON/OFF PRESHOT ANA&LYSIS METHOD
en la ventana que se muestra a la g (0 DNAMIC METHOD Figura 5.4.20

derecha.

Para el ajuste de las tomas previas,
los ajustes mostrados reflejan un
tiempo de exposicion de 26 kV y
3 segundos con una intensidad
objetivo de 10.000 UAD. Los
usuarios pueden introducir la
seleccidon de parametros de la toma

previa seleccionando solamente
DYNAMIC METHOD (METODO
DINAMICO) en la seccion

ANALYSIS METHOD (METODO DE
ANALISIS). La seleccién de STATIC
METHOD (METODO ESTATICO)
utilizara parametros predefinidos por
Faxitron. Ademas, el usuario tendra
la opcién de seleccionar los ajustes
de kV y tiempo de exposicion en la
seccion EXPOSURE  TUNING
METHOD (METODO DE AJUSTE
DE LA EXPOSICION).

Para obtener unas imagenes mas
precisas, el usuario podra introducir
el grosor de SOFT TISSUE (Sample)
(TEJIDO BLANDO [Muestra]) y

& [hcquire Preshat Image Before Every Image, Analyze and
Tune Settings]
~

DNamIC PRESHOT PREFEREMCES

PRESHOT k¥ DESIRED [kv] 260
2.00

‘[1]NEINE,D\‘SEAHD PRESHOT, SHOW AEC SHOT ALONE j

PRESHOT TIME DESIRED [g]

PRESHOT COMEINATION

,_
T
—

ExPOSURE TUNING METHOD
@ AUTORY /BUTOTIME O AUTO KV / FIXED TIME

7.30 45.0

THICKNESS/BEAM HARDENING A0VEREURN

[¢ AUTO DETECT SAMPLE THICKNESS
FROM PRESHOT/PRELOADED IMAGE

7 FIMED k¥ /AUTO TIME

I ENABLE OWERBURM PROTECTION

" Preshot and AEC shot are
assumed to have similar
sample+tray thicknesses

ENTER SOFT TISSUE EQUIVALENT -
SAMPLE +TRAY THICKNESS 0] 0.00"=0.00 em

TARGET INTENSITY

ENTER DESIRED MEAN
INTENSITY UNDER SAMPLE [ADU]

* GEMERAL RECOMMENDATION: Use
E0-30% of Mean Flat Field Value For
Satistactony Results

’W
ey

TARGET INTENSITY (INTENSIDAD DEL OBJETIVO) en las UAD. Nota: Los valores de Ia
imagen superior son solo un ejemplo. Es necesario determinar los valores correctos.

Nota: Los valores en la imagen superior son los tipicos para el sistema Faxitron Path. Debera
determinar los valores exactos para su sistema.

Para el modo AUTOMATIC EXPOSURE CONTROL (CONTROL DE LA EXPOSICION
AUTOMATICA), pulse el botén Start (Comenzar) en el software Vision (o en el panel de
control). Para crear una region de interés (ROI) y obtener los parametros de exposicion para la
exposicion 6ptima de la imagen, el software Vision realizara una toma previa (exposicion previa

a una dosis breve y baja) de la muestra.

Utilidad Login (Inicio de sesion)

La Login Utility (Utilidad de inicio de

sesion) que esta en el menu
ADVANCED TOOLS (Herramientas
avanzadas) permite al  usuario

configurar y activar la autenticacién con
contrasefia de inicio del software Vision.
En el sistema Faxitron Path, la
activacion de esta funcion es opcional.
Si el usuario activa la autenticacion con
contrasefa, se le pedira cada vez que
abra el programa. Si no se introduce la
contrasefia correcta, el programa se
cerrara.

Current Password:

NEW PASSWORD |
REENTERNEW |

CHAMGE
PASSWORD:

FASSWORD

AUTHENTICATE
OPTION:

W Enforce User Authentication on Software Startup

Apply Changes

Cuadro de diglogo Preshot AEC
Setup (Configuracion del CAE de
una toma previa)

Figura 5.4.21

Login Utility (Utilidad de
inicio de sesioén). En la
autenticacion del inicio
aparecera esta misma
pantalla.
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Properties (Propiedades) 5.4.4 Cont.
«Properties» (Propiedades) oculta o muestra el cuadro de informacion de la imagen. Véase la
Figura 5.3.9.

Edit Current Image Record (Editar el registro de imagen actual)

Actualmente no se utiliza.

Delete Current Image Record (Eliminar registro de imagen actual)
Elimina la imagen actual del directorio de archivos, tal y como se especifica en el archivo de
configuracion.

Add Current Image Record (Agregar registro de la imagen actual)
Afade la imagen actual al directorio de archivos, tal y como se especifica en el archivo de

configuracion.

Capture Screen Shot JPG/BMP (Realizar captura de pantalla en
JPG/BMP)

Seleccionando esta opcién del menu, el usuario puede realizar una captura de pantalla de la
ventana activa mostrada. El usuario puede especificar un nombre de archivo y elegir entre
JPG y BMP como formato de archivo guardado.

Save/Store Current Image (Guardar o almacenar la imagen actual)

El usuario puede «navegar» hasta el directorio o la carpeta de archivos en la que desee
guardar la imagen. Debera asignarse un nombre de fichero en el campo proporcionado.
Seleccione un formato de tipo de archivo en el que guardar la imagen. Se proporcionan
numerosos tipos de archivo. Para guardar el archivo en formato DICOM, consulte la seccién
«DICOM Functionality» (Funcionalidad DICOM).

Print Current Image (Imprimir imagen actual)

Imprime la imagen actual en la impresora de WINDOWS.

545
Image Tools (Herramientas de imagen) Herramientas de

Para editar la imagen obtenida o recuperada, estan disponibles las siguientes funciones imagen
haciendo clic en el menu «/mage Tools» (Herramientas de imagen). Véase la Figura 5.4.22.

Con un solo clic sobre la opcidn deseada, se podra acceder -
a o activar las opciones del submen. RMGCRRECEN DICOM Utilities

o Figura 5.4.22
Original Contrast Ment Herramientas de imagen

Invert

Magnifier
Enhance

ROI Contrast

ROI Window Level
Ruler

ROI Statistics

ROI Histogram
ROI Profile

Line Profile
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Original Contrast (Contraste original)

«Original Contrast» (Contraste original) restaura los niveles de contraste de la imagen. Esto
sirve para el mismo propdsito que el boton Original Contrast (Contraste original) en la
herramienta Window Level and Contrast (Nivel de la ventana y contraste). Véanse la
Seccion 5.4.1y la Figura 5.4.3.

Invert (Invertir)

«Invert» (Invertir) hace que la imagen visualizada se invierta o revierta. Al invertir una imagen,
se invierte su transparencia: lo que es negro se convierte en blanco y lo que es blanco se
convierte en negro. A los grises se les asigna su transparencia espejo. Para desactivar la
funcion, haga clic de nuevo en «/nvert» (Invertir). Realiza la misma funcion que el boton Invert
(Invertir). Consulte la Seccion 5.4.1 y las Figuras 5.4.3y 5.4.4.

Ampliar

«Magnify» (Ampliar) permite al usuario ampliar un area de interés. Para utilizar la funcién Magnify
(Ampliar), sitte el cursor del raton sobre el area que desee ampliar y haga clic con el botén
izquierdo del raton. Se ampliaré el area de interés. Para desactivar la funcién, haga clic de nuevo
en «Magnify» (Ampliar). Consulte la Figura 5.4.23. El usuario podra ajustar el tamafio del area de
interés ampliada. Consulte el submenu «Magnifier Size» (Tamafo de la lupa) en la Seccion 5.4.3.

Edge Enhance (Realce de los bordes)

«Edge Enhance» (Realce de los bordes) definira con mayor nitidez los bordes de las regiones
utilizando una diferencia de contraste. Puede que el realce de los bordes amplifique el ruido en
las imagenes en general. Seleccionando de nuevo la opcién del menu, se desactivara el realce
de bordes. Si hace clic en «Original Contrast» (Contraste original), la imagen volvera a su
estado original. Tenga en cuenta que esta es una funcién diferente a la funciéon Enhance Image
(Mejorar la imagen) de la Seccion 5.4.1y 5.4.3.

ROI Contrast (Contraste de la ROI)

«ROI Contrast» (Contraste de la ROI) optimizara los niveles de contraste del interior de una
region de interés (ROI) definida por el usuario. Después de seleccionar «ROI Contrast»
(Contraste de la ROI), haga clic y mantenga pulsado el botén izquierdo del ratén en el punto
inicial de la ROl deseada, arrastre el raton y suelte el boton del raton en el punto final de la ROI
deseada. El contraste se ajustard automaticamente a los mejores niveles para esa ROI. (Para
mas informacién sobre la ROI, consulte la seccidn Definiciones).

ROI Window Level (Nivel de ventana de la ROI)

La funcién «ROI Window Level» (Nivel de ventana de la ROI) no esta disponible en la version
actual del software Vision.

Figura 5.4.23
Ampliar
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Regla

«Ruler» (Regla) permite al usuario medir la distancia entre dos puntos de la imagen visualizada.
Las medidas de longitud se expresan en milimetros (mm). Después de seleccionar «Ruler»
(Regla), haga clic y mantenga pulsado el botén izquierdo del ratén y, empezando por el punto
inicial de la medicion, arrastre el raton y suelte el boton del ratén en el punto final de la medicion.
En la imagen, la regla tiene el aspecto de una linea roja.

Figura 5.4.24

La medicion (en mm) se muestra al
Regla

final de la regla. Hasta que el
usuario seleccione otra
herramienta de imagen o hasta
que se realice otra accion, la regla
permanecera activa. Véase la
Figura 5.4.24 a la derecha. Para
desactivar la funcién, haga clic de
nuevo en «Ruler» (Regla).

Sugerencia: para obtener una
linea perfectamente recta o una
linea en un angulo perfecto de 45
grados, mantenga pulsada la tecla
SHIFT (del teclado) mientras
mantiene pulsado el boton
izquierdo del ratén y arrastre.

Estadisticas de la ROI

«ROI Statistics» (Estadisticas de la ROI) mostrara un cuadro de didlogo que contiene estadisticas
de la imagen. Haga clic y mantenga presionado el botén izquierdo del ratdn sobre la region de
interés (ROI) de la imagen principal, arrastre el cursor para hacer la seleccion alrededor del érea
y luego suelte el botdn del ratdn. La informacion estadistica de la region seleccionada se mostrara
en el lado izquierdo del cuadro de dialogo y la de toda la imagen, en el lado derecho del recuadro.
Las estadisticas que se muestran son: los puntos inicial y final de la ROI, los valores de intensidad
Minimum (Minimo), Maximum (Maximo) y Mean (Medio) y Standard Deviation (Desviacion
estandar) (STD). Para cerrar el cuadro de informacion Statistics (Estadisticas), simplemente haga
clic en el boton Close (Cerrar). Véase la Figura 5.4.25. Para desactivar la funcién, haga clic de
nuevo en «ROI Statistics» (Estadisticas de la ROI).

Figura 5.4.25
Estadisticas de la ROl

Selected Region Whale Image

[T op Left)=[583.1383) [Top.Left)=(00]
[Battorn,Right)=[1183,2558) [Buottor, Right)=(3072,3833]

Minirnurm: 516 Mirirnurn: 523

M awirnurn: 7537 M awirnurn: 14042
Mean:5620.00 Mean: 606,26
STD: 555.60 STO:4026.28
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Histograma de la ROI

«ROI Histogram» (Histograma de la ROI) creara un histograma para una ROI definida por el
usuario. Después de seleccionar la opcién del menu, coloque el cursor del ratdén en la imagen
visualizada, mantenga pulsado el botén izquierdo del ratén y arrastrelo para seleccionar la ROI
deseada. Suelte el botdn del ratén. Se mostraran histogramas de la ROI seleccionada. Véase
la Figura 5.4.6.

La curva negra es el histograma de la region seleccionada. La curva azul es el histograma de
toda la imagen. Ambas curvas se normalizan contra el valor maximo de pixeles de la region de
interés seleccionada. Para desactivar la funcion, haga clic de nuevo en «ROI Histogram»
(Histograma de la ROI).

Histogram

100.00
90.00
80.00
7000
60.00
5000
40.00
30.00
2000

10.00 ﬂ‘m

0.005

Relative Number of Pixels

9000.0

@
Intensity Level
SAVEASTXT|  PRINT

Perfil de la ROI

«ROI Profile» (Perfil de la ROI) creara un perfil para una ROI definida por el usuario. Después de
seleccionar la opcion del menu, coloque el cursor en la imagen visualizada. Para dibujar un
cuadro definido por el usuario alrededor de la ROl deseada, mantenga pulsado el botén izquierdo
del ratén y mueva el cursor por la imagen. Suelte el botén izquierdo del ratén y aparecera un perfil
que mostrara los valores de cada pixel de la ROI definida. Véase la Figura 5.4.27. Por defecto,
la direccion de la promediacion de la ROl seleccionada es el eje corto. El eje puede desplazarse
hacia adelante y hacia atrés seleccionando el boton SWITCH, HOR<->VERT (CAMBIAR
HORIZONTAL<->VERTICAL). Para desactivar la funcion, haga clic de nuevo en «RO/ Profile»
(Perfil de la ROI).

| @

Horizontal Region Profile
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Figura 5.4.26
Histograma de la RO/

Figura 5.4.27
Perfil de la ROI
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Perfil de la linea

«Line Profile» (Perfil de la linea) mostrara el perfil de una linea definida por el usuario. Después
de seleccionar «Line Profile» (Perfil de la linea), coloque el cursor en la imagen visualizada.
Para dibujar una linea definida por el usuario, mantenga pulsado el botdn izquierdo del ratén y
mueva el cursor por la imagen. Suelte el boton izquierdo del ratén y aparecera un perfil que
mostrara los valores de cada pixel de la linea definida. Véase la Figura 5.4.28. Por defecto, el
primer punto seleccionado es siempre la parte izquierda (mas cercana al origen) del grafico (es
decir, el eje horizontal del grafico puede tener indices de pixeles (i, i) crecientes o decrecientes,
dependiendo de los puntos inicial o final que se hayan seleccionado). Para desactivar la
funcion, haga clic de nuevo en «Line Profile» (Perfil de la linea).

.,

i Line Profile

7500.00
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5400.00
4700.00
4000.00
3300.00
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1900.00
1200.00

500.005

o
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©
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2400
3600
4800
7200
8400
1080.0
12000

=)
©
=

Index on the Line From Point (2235.861) To (3362 858)

saveasTa1| ANt | [ eose

Nivel de ventana incorporado

El software Vision incluye una funcion de Window Level (Nivel de ventana) «incorporado». Para
seleccionarlo, no hay ningun botén ni elemento del menu. La funcién Window Level (Nivel de
ventana) se activa automaticamente cada vez que se obtiene una imagen o se recupera de la
base de datos para revisarla. Esta funciéon permite al usuario ajustar los niveles de contraste y
brillo de la imagen utilizando el ratén o el cursor.

Para ver los niveles de brillo u oscuridad, haga clic y mantenga pulsado el botén izquierdo del
ratén sobre la imagen visualizada y mueva el cursor hacia arriba y hacia abajo, 0 mueva el
cursor hacia la izquierda o hacia la derecha para subir o bajar el contraste. Mueva el cursor
hasta que la imagen se encuentre en los niveles deseados.

Figura 5.4.28
Perfil de la linea
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Presionando el botén, mostrado en la Figura 5.5.1 y ubicado en la parte inferior de la ventana
de obtencidon de imagenes, aparecera la secuencia de imagenes en miniatura del paciente
actual. Véase la Figura 5.5.2.

N

BROWSER

En texto naranja y a lo largo de la parte superior, la secuencia de miniaturas mostrara la fecha
en la que se realizé el procedimiento de cada serie de imagenes individuales.

Se iluminara en verde la imagen actual que aparece mostrada en la ventana de obtencion de
imagenes.

Para colocar las imagenes en la pantalla o en los paneles de revision, la secuencia de
miniaturas permite realizar las operaciones «arrastrar» y «soltar», segun sea necesario.

Ademas, con un solo clic, el usuario podra seleccionar varias imagenes y, a continuacion,
seleccionar entre las diferentes opciones para guardar las imagenes en una unidad USB, enviar
las imagenes al SACI o borrar las imagenes. Las imagenes seleccionadas apareceran
resaltadas en naranja.

Hay flechas situadas a la izquierda y a la derecha. En caso de que se tomen gran cantidad de
imagenes, pulsando las flechas izquierda o derecha el usuario podra recorrer por fecha
ascendente las imagenes tomadas.

También se incluye la opcion Open the Database (Abrir la base de datos) (véase la
Figura 5.5.3), que entra en el modo Review (Revision). Este mismo boton es el equivalente a
pulsar Review Mode (Modo de revisién) en Home Menu (Menu de inicio). Véanse las
Figuras 5.0.1y 5.6.1.

Se puede entrar en el modo de revision haciendo clic en el botén Review (Revisar) de la pagina
Home Menu (Menu de inicio), Figuras 5.6.1 y 5.0.1, o en el boton Open Database (Abrir base
de datos) de Current Image Browser (Explorador de imagenes actuales). Véase la Figura 5.5.3.
Al hacer clic en cualquiera de estos botones, se abrira la base de datos como
se muestra en la Figura 5.6.2. Mientras esté en modo de revision, el sistema @
estara en modo de espera.

Review

La base de datos se compone basicamente de tres secciones o subventanas. La seccién
Patient List Table (Tabla de la lista de pacientes) a la izquierda, la seccién Procedure List Table
(Tabla de la lista de procedimientos) en la parte superior derecha y la seccion Image Thumbnail
List/Viewer (Lista/Visor de imagenes en miniatura) en la parte inferior derecha.

Explorador de
imagenes del
paciente actual

Figura 5.5.1
Icono del explorador de imagenes
del paciente actual

Figura 5.5.2
Explorador de imagenes del
paciente actual

Figura 5.5.3

Boton de la base de datos de las
imagenes

Base de datos
Figura 5.6.1

Icono del modo Review (Revision)
del ment de inicio

Figura 5.6.2
Base de datos de las imagenes
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Como indica la flecha, las tablas de listas funcionan en una jerarquia de arriba hacia abajo:

The Patient List (Lista de pacientes) ---> Procedure List (Lista de procedimientos) ---> Image
Thumbnail List/Viewer (Lista/Visor de imagenes en miniatura).

La ventana de seleccidon Patient (Paciente) es la ventana superior izquierda. La ventana
Procedure (Procedimiento) es la ventana superior derecha.

Cuando se selecciona un campo Patient (Paciente), se activa la ventana Procedure
(Procedimiento). La ventana Procedure (Procedimiento) muestra una lista de todos los
procedimientos realizados en el paciente seleccionado. Ademas, todas las imagenes
correspondientes al paciente se mostraran en la parte inferior derecha. No es posible
seleccionar a varios pacientes.

Cuando se selecciona un procedimiento, la lista de imagenes en miniatura/visor se filtrara para
mostrar solamente las imagenes que corresponden al procedimiento seleccionado. Se pueden
seleccionar varios procedimientos manteniendo pulsada la tecla Mayusculas y haciendo clic
con el botdn izquierdo del ratén en cada procedimiento. Se mostraran las imagenes
correspondientes de los procedimientos seleccionados.

e Puede ajustarse la eleccion en la base de datos haciendo clic en los campos superiores, como
Patient ID (ID de paciente) y Last Name (Apellido), para ordenarla por uno u otro campo.
Cuando se haga clic con el cursor del raton sobre uno de los campos de la base de datos, se
mostrara un pequenio indicador de flecha dentro del campo. Usando el boton izquierdo del ratdn
y seleccionando el campo de nuevo, la flecha cambiara de ascendente a descendente o
viceversa. El campo seleccionado correspondiente se ordenara automaticamente.

o Para facilitar la navegacion, hay barras de desplazamiento en la base de datos.

e Para afadir automaticamente la imagen a un panel de revision, la lista de miniaturas/visor
permite al usuario hacer clic en el simbolo «+». Un usuario puede anadir hasta cuatro
imagenes en los paneles de revision. Los paneles de revisién se ajustaran automaticamente
para abarcar las cuatro imagenes.

e Las mismas opciones disponibles en Current Patient Images Browser (Explorador de
imagenes del paciente actual) (véase la Figura 5.5.2) estan también ubicadas en la parte
superior de la base de datos. No obstante, también se ofrecen mas opciones, que aparecen
descritas en la Seccion 5.5.2.

Nota importante: las imagenes en miniatura (.PNG) son archivos independientes de los
archivos de datos de imagen reales (DCM, DAT, DMM, RAW). Tienen el mismo nombre de
archivo que el archivo de imagen, pero tienen una extensién de archivo (.PNG). Puede que
haya un archivo de imagen sin «miniatura». En ese caso, Vision intentara crear una miniatura
automaticamente para que la imagen se cargue en la base de datos. Sin embargo, si esto no
se pudiera hacer, la imagen no se mostrara.

Save Image(s) (Guardar imagenes)

El boton Save Image(s) (Guardar imagenes) aparece al seleccionar una entrada de Image
Table (Tabla de imagenes) o Thumbnail List (Lista de imagenes en miniatura), o en las
imagenes del paciente actuales; de lo contrario, se desactivara. La imagen seleccionada se
podra guardar en los siguientes formatos de 8 bits: JPEG, BMP, TIFF y RAW. También se
podré guardar en formato TIFF de 16 bits.

El nivel de ventana de la imagen guardada es el nivel de ventana predeterminado. Si el usuario
requiere que el nivel de la ventana esté organizado, debera cargar la imagen en Image View
(Vista de imagen) e imprimir desde alli, en lugar de imprimir desde el cuadro de dialogo de la
base de datos.

Send Image(s) to PACS (Enviar imagenes al SACI):

Esta funcion envia las iméagenes a un servidor SACI de DICOM preconfigurado. Para obtener
mas informacién, consulte la Seccion 5.7.0.
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Funciones y herramientas del menu de la base de datos o de 5.6.1
imagenes Opciones

Hay funciones para explorar y buscar en la base de datos, adicionales de la
asi como para editar, borrar y afiadir registros a la base de ADDITIONAL OPTIONS base de datos
datos. Estas funciones se explican a lo largo de los
elementos del menu de la base de datos. Se accede a ellas OFE” Figura 5.6.3
desde el boton de nivel superior denominado Additional Print Ment Additional Options
Options (Opciones adicionales) dentro de la base de datos. View (Opciones adicionales)

Search

Tools

Close Database

Menu Open (Abrir)
El menu «Open» (Abrir) solamente tiene una opcion, «Open Image from File» (Abrir imagen
desde archivo), que abre un cuadro de didlogo de Windows que permite al usuario navegar y
abrir archivos de imagen ubicados en unidades locales o de red.
Menu Print (Imprimir)

El menu «DB-PRINT» Figura 5.6.4

(IMPRIMIR BASE DE DATOS) : :

L. . L . Print Image to Local Printer
ofrece la funciéon de impresion o s
de imagenes, procedimientos o ) Tt Imegets) fo ikl

pacientes. Véase la Figura 4.6.4.

Print Image to Local Printer (Imprimir imagen en la impresora local)

«Print Image to Local Printer» (Imprimir imagen en la impresora local) esta disponible cuando
se selecciona la entrada en la tabla de imagenes o en la lista de imagenes en miniatura; de lo
contrario, estara desactivada. La imagen seleccionada se imprimira utilizando la impresora
local predeterminada del sistema Windows.

El nivel de ventana de la imagen impresa es el nivel de ventana predeterminado. No se
recomienda que los usuarios impriman desde este menu, a menos que estén satisfechos con
las impresiones establecidas en los niveles de ventana predeterminados y calculados por el
programa. El usuario podra cargar la imagen primero en la ventana Image View (Review) (Vista
de imagen [Revision]) y luego ajustar la imagen a los niveles de ventana deseados. Cuando
esté satisfecho con el nivel de la ventana, el usuario podré iniciar la impresion desde el menu
de la ventana de Image View (Vista de imagen). El cuadro de didlogo Format Options (Opciones
de formato) ofrece la posibilidad de elegir entre formatos de impresion.

Print Image(s) to DCM Printer (Imprimir imagenes en una
impresora DCM)

Esta funcion envia las imagenes a una impresora DICOM preconfigurada.

Menu View (Ver)
El menu «View» (Ver) ofrece al usuario una serie de opciones que afectan a la vista de la base
de datos. Véase la Figura 5.6.5.

Print

Show All DB Entries
Search Refresh DB Entries

Tools Browse Data Dir. (No DB)
Browse Any Dir. (No DB)

Ment Impresion de la base de
datos

Figura 5.6.5
Ment Ver base de datos
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Show All DB Entries (Mostrar todas las entradas de la base de datos)

Recarga la tabla de pacientes desde el archivo de base de datos. Cualquier cambio o adicion a
la base de datos se aplicara a la tabla. Esta seleccion también borrara cualquier Search Filter
(Filtro de busqueda) activo que se haya aplicado a las tablas. Search Filter (Filtro de busqueda)
se explica a continuacion en detalle en el tema Database Search (Busqueda en la base de datos).

Refresh DB Entries (Actualizar entradas de la base de datos)

Actualiza la tabla Patient (Paciente), pero mantiene cualquier filtro de busqueda existente que
se haya aplicado.

Browse Data Directory (No DB) (Explorar el directorio de datos
[no la base de datos])

Muestra todas las imagenes en miniatura en el directorio Data (Datos) establecido por el
archivo de configuracion. Estos archivos se muestran en el Visor de miniaturas. No estan
asociados a la base de datos ni a las listas de tablas. Esta herramienta es util para revisar
imagenes no grabadas o para depurar problemas de la base de datos con imagenes en el
directorio de datos actual.

Browse Any Directory (No DB) (Explorar cualquier directorio [no
la base de datos])

Permite al usuario navegar a cualquier directorio de archivos. Estos archivos se muestran en
el Visor de miniaturas. No estan asociados a la base de datos ni a las listas de tablas. Esta
herramienta es util para revisar un directorio de imagenes que nunca fue grabado en la base
de datos, o cuando los registros de la base de datos estan dafiados.

Menu de busqueda

Las herramientas de «Search» (Busqueda) de la base de datos, véase la Figura 5.6.6,
proporcionan busquedas detalladas o filtrado de la base de datos. Seleccionando el menu «DB-
Search» (Busqueda en la base de datos) el usuario puede realizar una busqueda detallada y
especifica. Cuando se introducen y activan los criterios de busqueda en el cuadro de dialogo de
busqueda de la base de datos, véase la Figura 5.6.7, el filtro de busqueda se aplicara a todas las
tablas de listas del cuadro de dialogo de la base de datos de imagenes. El criterio de busqueda
activado se denomina Search Filter (Filtro de busqueda) y este filtro permanece activo hasta que
el usuario selecciona «Stop Search» (Detener busqueda) en el menu «DB-Search» (Busqueda
en la base de datos) o «Show All DB Entries» (Mostrar todas las entradas de la base de datos)
en el menu «DB-View» (Vista de
la base de datos). El filtro de _
busqueda activo siempre se
muestra en el titulo del cuadro de

didlogo Image Database (Base Stop Search

de datos de imagenes).

Start Search (Iniciar busqueda)

«Start Search» (Iniciar busqueda) abre el didlogo de busqueda de la base de datos que permite
al usuario colocar un filtro de busqueda activo en la base de datos. Cuando se abre el didlogo
de busqueda, se cierra la pagina _
Database (Base de datos) y el [(BBSEARCH Disiog ==
software vuelve a la pagina
Image Acquisition (Obtencién de

SEARCH BY: Enter ACCESSI0M NUMBER

. ., 2 [ oM Limbs b

imagenes). La pagina Database [ezsiniael =

(Base de datos) se reabrira CLICK 0K~ TO ACTIATE SEARCH FILTER ON THE DATABASE
automaticamente después de e

cerrar el cuadro de diadlogo
Search (Buscar).

Los menus desplegables proporcionan una lista de las categorias de busqueda. Seleccione
una categoria de busqueda y escriba el parametro de busqueda deseado para iniciar la
busqueda. Para iniciar la busqueda, seleccione «Start» (Comenzar). Si la categoria puede
tener mas de una entrada discreta, se mostraran todas las entradas de esa categoria.

5.6.1 Cont.

Figura 5.6.6
Menu de busqueda en la base de
datos

Figura 5.6.7
Cémo iniciar una busqueda en la
base de datos
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Stop Search (Detener la busqueda) 5.6.1 Cont.
«Stop Search» (Detener la busqueda) desactiva cualquier filtro de busqueda activo, borra todas
las tablas de la lista y vuelve a cargar la lista de todos los pacientes a la tabla de lista de pacientes.
Menu Tools (Herramientas)

El menu «DB-Tools» ofrece funciones de imagen, procedimiento o paciente, asi como algunas
funciones utiles para reparar o reformatear la base de datos.

view Figura 5.6.8

Search
Edit Image Record

e T Add Record to DB

Import Records in DIR to DB
Reformat All DB

Edit Image Record (Editar registro de imagen)

La funcién «Edit Image Record» (Editar registro de imagen) no esta disponible actualmente en
el software Vision.

Add Record to DB (Anadir registro a la base de datos)

Disponible cuando se selecciona la entrada de Image Table (Tabla de imagenes) o de
Thumbnail List (Lista de imagenes en miniatura); de lo contrario, estara desactivada. Esto es
especialmente util cuando se navega por un directorio sin que la base de datos tenga entradas
disponibles para las imagenes en ese directorio. El usuario puede seleccionar una sola imagen
de la lista de miniaturas y afadir registros de esa imagen a la base de datos. Si la entrada de
la base de datos ya existe para la imagen seleccionada, no causara ningun dafio; solamente
puede actualizar la base de datos en términos de donde se encuentra actualmente el archivo
de imagen, es decir, el nombre del archivo/carpeta.

Import Records in DIR to DB (Importacion de registros del
directorio a la base de datos)

Esta herramienta ayuda a buscar y seleccionar una carpeta y, a continuacion, a rellenar la base
de datos con todas las entradas correspondientes para todos los archivos de imagen del
directorio seleccionado (incluidos los subdirectorios). Los formatos de las imagenes pueden
ser DCM, DAT, DMM y RAW. Si faltan miniaturas de imagenes, esta herramienta también
generara miniaturas de BMP en el mismo directorio.

Reformat All DB (Reformatear toda la base de datos)

La herramienta «Reformat All DB» (Reformatear toda la base de datos) ayuda a reformatear
los campos Date [YYYY/MM/DD] (Fecha [AAAA/MM/DD]), Date/Time [YYYY/MM/DD
HH:MM:SS] (Fecha/Hora [AAAA/MM/DD HH:MM:SS]) de las tablas, y también escribe en
mayusculas las letras de las entradas de algunos otros campos. Es una herramienta util cuando
algun archivo de base de datos mas antiguo se importa y abre por primera vez, o cuando el
usuario altera manualmente las entradas de la base de datos utilizando MS Access.

Notas adicionales en la base de datos

e La posibilidad de salir de la base de datos permaneciendo dentro del modo Revisién se
encuentra en Additional Options (Opciones adicionales).

o El botdn de la parte superior izquierda se ajustara para llevar al usuario Back to Acquisition
(De vuelta a la obtencién), Back to the Main Menu (De vuelta al menu principal) o se convertira
en el botén Close Database (Cerrar base de datos), dependiendo del flujo de trabajo utilizado
para entrar en la pantalla Database (Base de datos) y de lo que sea mas conveniente.

Ment Herramientas de la base de

datos
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Editar o eliminar de la base de datos la informacion sobre el paciente  5.6.1 Cont.

El usuario puede editar o borrar la informacién sobre el paciente desde la base de datos. Para
abrir un cuadro de dialogo, haga clic con el botén derecho en la entrada del paciente situada
en la seccion superior de la base de datos. Véase la Figura 5.6.9.

Figura 5.6.9
Cuadro de dialogo Editar/eliminar
(izquierda)

1D6758 2019/03/3

D56 2019/ 5
Patient Name:

* -
A Figura 5.6.10
Informacién sobre el paciente

Date of Birth:
(derecha)
Sex: I

1D8679 e |

Delete Patient Information

Al hacer clic en «Edit Patient Information» (Editar
informacion sobre el paciente), se abrira un
cuadro de didlogo «Patient Information»
(Informacion sobre el paciente). Véase la Figura
5.6.10. Para volver a la base de datos sin realizar <
ni guardar los cambios, haga clic en Cancel
(Cancelar). Al hacer clic en Save Changes
(Guardar cambios), se abrira un cuadro de dialogo de «Confirmation» (Confirmacién). Para
confirmar y continuar, haga clic en Yes (Si). Los cambios se guardaran y el usuario volvera a
la base de datos. No anulara los cambios y volvera a la base de datos. Cancel (Cancelar)
regresara al usuario al cuadro de dialogo «Patient Information» (Informacién sobre el paciente).

Save Changes >

Nota: Si el sistema tiene activada una contrasefia de puesta en marcha (consulte el tema Login
Utility [Utilidad de inicio de sesion] en la Seccion 5.4.4 y la Figura 5.4.21), se le pedira la misma
contrasefia cuando intente «Delete Patient Information» (Eliminar la informacion sobre el
paciente) en la base de datos.

5.7.0
El estandar DICOM Funcionalidad

¢ Qué es el estandar DICOM? DICOM

El Estandar de Imagenologia Digital y Comunicaciones en Medicina (DICOM) es una serie de
protocolos utilizados por equipos y software médicos para permitir que los datos sean
compatibles e intercambiables con otros equipos o software médicos.

Cuando se guarda un archivo en formato DICOM, se crea un archivo que incluye los datos
relevantes del paciente, el equipo de obtencion de imagenes, los datos del hardware y los datos
de las imagenes, todo en un solo archivo. Ademas, el archivo guardado contiene caracteristicas
especificas identificadas por el ordenador y el software como archivo de estandar DICOM. Una
vez que una aplicacién de software reconoce el archivo como un archivo de estandar DICOM,
puede iniciar un lector DICOM vy extraer los datos correctamente, independientemente del
origen del archivo.

Un archivo creado utilizando el protocolo DICOM tiene la siguiente estructura: Figura 5.7.1
Estructura del protocolo DICOM

Preambulo Encakezado

Prefijo

Cuando el preambulo consta de 128 bytes, todos ellos
normalmente configurados en 00H, a menos que no sean
utilizados por un perfil de aplicacion o una implementacion Elemento de datos
especifica, el prefijo consta de 4 bytes, que constituyen la cadena
de caracteres «DICM» codificada como caracteres en mayuscula
del repertorio de caracteres ISO 8859 GO0, y los elementos de los
datos son arbitrariamente grandes (o pequefios) y contienen los Elemento de dates Conjunte
datos. de dates

Elemento de datos

Elemento de datos

Elemento de datos

Elemento de datos
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Modalidad
Para acceder a la configuracion de la modalidad de los archivos DICOM, desde la barra de
menu superior, seleccione «DICOM Utilities» (Utilidades de DICOM) y, a continuacion,
«DICOM Modality Setup» (Configuracion de la modalidad DICOM). Figura 5.7.2

DICOM Ltilities gl

DICOM MODALITY Setup
DUMP DICOM Header

Es posible seleccionar el tipo de almacenamiento DICOM, ya sea Presentation (Presentacion)
o Processing (Procesamiento). EI mismo cuadro de didlogo permite seleccionar la modalidad
de imagen DICOM, ya sea Digital X-Ray (Radiografias digitales) o Digital X-Ray Mammography
(Mamografia digital de rayos X). El usuario no puede definir Transfer Syntax (Sintaxis de
transferencia) ni Value Representation (Representacion de valores). Siempre se asignan para
que sean META HEADER PRESENT (con etiquetas meta en el encabezado), LITTLE_ENDIAN
(extremidad pequefia) y VR_IMPLICIT (realidad virtual implicita).

DICOM Storage Type Walue Fepresentation

{* Storage For Presentation * |rnplicit

" Storage For Processing (" Ewplicit*

DICOM Image kaodality Transfer Syntax

(# Digital ¥-ray Image [General] & Litle Endian

(™ Digital -ray Mammoagraphy Image ™ Big Endian®

[l IMPLICITAFR and LITTLE-EMDIAN syntax is recommendead. Other options may
nat be fully compatible with third party software or DICOM services. IMPLICIT AR
and BIG-EMDIAN cannat be simultaneously selected,

Default DICOM Servers
STORET |

STORE 2 |
[v Enable Single-Click Auba Store

PRINT |
[ Enable Single-Click Auto Print

MWL |

[v Enable uto Search When Connecting to MWL Server
[¥ Enable Single-Click &uto ML Connection

[ Autocloze dialog after 5 zeconds of successiul ransfer/printing.

Click DICOM Servers button to add. configure
DICOM Servers... | o delste DICOM servers.
[u]8 | Cancel

Nota: Cuando las modalidades DICOM se han seleccionado, permanecen en efecto incluso
después de que el software Vision se ha cerrado. Los ajustes de modalidad se almacenaran y
permaneceran en la forma configurada hasta que se cambien de nuevo utilizando DICOM File
Settings (Ajustes del archivo DICOM). Estos ajustes (Storage Type & Modality, Transfer Syntax
y Value Representation) (Tipo y modalidad de almacenamiento, sintaxis de transferencia y
representacion de valores) seran efectivos para todas las funcionalidades DICOM Local Save
(Almacenamiento local) o Print (Impresion).

Menu Utilidades de DICOM

Figura 5.7.3

Ajustes de la modalidad DICOM
Se muestran los ajustes
predeterminados
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Default DICOM Servers (Servidores DICOM predeterminados)

Esta seccion contiene la configuracion para los servidores DICOM predeterminados y para
automatizar algunos de los procesos al almacenar, imprimir o buscar servidores SACI y MWL.

Las casillas de verificacion «Enable Single-Click Auto Store» (Activar almacenamiento
automatico con un solo clic), «Print» (Imprimir) o kMWL Connection» (Conexion MWL) permiten
al usuario almacenar o imprimir imagenes, o conectarse automaticamente al servidor MWL. Si
usted utiliza un solo servidor SACI para esas acciones o la mayoria de su trabajo involucra un
solo servidor SACI, marque la casilla deseada para automatizar esas acciones.

«Enable Auto Search When Connecting to MWL Server» (Habilitar la busqueda automatica al
conectarse al servidor MWL) le indicara a la aplicacion que realice automaticamente una
busqueda con la configuraciéon de busqueda predeterminada al buscar los datos del paciente.

El cuadro de didlogo «Auto close dialog after N seconds of successful transfer/printing» (Cierre
automatico después de N segundos de transferencia o impresion correcta) cerrara
automaticamente el cuadro de dialogo DICOM Networking (Trabajo en red DICOM)
transcurrido un numero especificado de segundos. Si hubo un error en la transferencia o la
impresion, el didlogo no se cerrara automaticamente.

Al hacer clic en el boton DICOM Servers (Servidores DICOM), se abrira el cuadro de dialogo
DICOM Networking (Trabajo en red DICOM), donde el usuario podra afiadir, modificar o
eliminar servidores DICOM. Véase la Figura 5.7.5.

DICOM Save Local (Guardar como DICOM local)

Para guardar la imagen actual en una unidad local o directorio, haga clic con el boton derecho
en cualquier parte de la imagen. Esto mostrara el cuadro de didlogo que se muestra en la
Figura 5.7.4 siguiente. Haga clic en «Save/Store current image» (Guardar/almacenar imagen
actual) y, a continuacion, en «As local
DICOM image» (Como imagen

LI IETE CUITENT IMAge recora

. Add new record
DICOM local). Se abrira el cuadro de ;
d|é|ogo Windows File Save (Guardar Save/Store current image » LIS Archive image
archivo de Windows) estandar. Print current image » As local DICOM image

As local image

Busque o haga clic directamente en la
carpeta deseada, introduzca el
nombre del archivo y haga clic en
Save (Guardar).

More options...

PACS Store and PACS Print (Almacenamiento en SACIl e
impresion en SACI)

El software Vision permite el almacenamiento en SACI (DICOM) y la impresion en SACI
(DICOM). Estas opciones estan disponibles en todo el software. Por ejemplo, si se selecciona
el boton PACS Store :
(Almacenamiento en SACI),
se podra mostrar la siguiente

L. ession
ventana de didlogo de ek )
conexiones de red DICOM. MR s DICOM Store 1 DICOM Frint 1 BIEHHHT

L= 1|

24 DICOM Networking Dialog - Biop

SESSION  SECURITY VIEW COMMAND PREFERENCES

Session [ + | DICOM Metwork Connections

., REMOVE Session
Este ' cuadro .de cﬁalogo T
permite al usuario realizar un et Moo oo
DICOM Store
(Almacenamiento en

DICOM), una DICOM Print
(Impresién en DICOM) o Add | o |
(Agregar), Modify (Modificar)
o Remove DICOM Network —_—
connections (Eliminar

conexiones de red en
DICOM) o] Peripherals e

(Periféricos).

Figura 5.7.4

Cuadro de diglogo Guardar
imagen actual

Figura 5.7.5

Cuadro de diélogo Conexiones de

red DICOM
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PACS DICOM Store (Almacenamiento en DICOM como SACI)

El software Vision es compatible con el servicio DICOM 3.0 C-STORE. Esto permite enviar una
imagen o una serie de imagenes (bajo un procedimiento especifico) a un sistema de
almacenamiento remoto compatible con la entidad de aplicaciéon DICOM (AE), como, por
ejemplo, SACI. Una vez mas, la capacidad DICOM Store (Almacenamiento en DICOM) esta
prevista en todo el software Vision. Las modificaciones de Presentation (Presentacion) y
Processing (Procesamiento) se pueden realizar a través de DICOM Modality Setup
(Configuracién de la modalidad DICOM) bajo el menu Tools (Herramientas).

Nota: En DICOM Store (Almacenar en DICOM), «SET FILM Attributes» (Ajustar atributos de la
pelicula) se muestran en gris.

El usuario puede afadir una nueva configuracion para una entidad de aplicaciéon (AE) de
DICOM remota a la que enviar la imagen o seleccionar una ya configurada, que se muestra en
las conexiones DICOM Network (Red de DICOM) en el cuadro de dialogo DICOM Networking
(Conexiones de red de DICOM). Haciendo doble clic (o un solo clic y presionando el boton
Connect [Conectar]) en el icono de la entidad de aplicacion (AE) de DICOM remota, el software
Vision se conectara y establecera una asociacion DICOM con la AE remota seleccionada. Una
vez que la asociaciéon se haya establecido con éxito, la imagen se podra enviar para su
almacenamiento pulsando el botdn Store (Almacenar). Después de seleccionar el botén Store
(Almacenar), el software Vision enviara la imagen seleccionada a la AE de DICOM remota
definida. Si la operaciéon de almacenamiento tiene éxito, la AE de DICOM remota enviara una
confirmacion de recepcion y almacenamiento de las imagenes. Si la operacion falla, la AE de
DICOM remota enviara un cédigo de error indicando la razén del fallo.

Una sola imagen también puede ser enviada para su almacenamiento haciendo clic en el botén
derecho del raton sobre la imagen en «miniatura» mientras esta en el navegador de la base de
datos y siguiendo el mismo procedimiento descrito anteriormente. Es posible enviar una Series
(Procedure) (Serie [Procedimiento]) completa de imagenes para su almacenamiento. Esto se
logra haciendo clic en el boton derecho del ratdon en el nombre de la Series (Procedure) (Serie
[Procedimiento]), que aparece en la pantalla del navegador de la base de datos y de nuevo,
siguiendo el mismo protocolo descrito anteriormente.

Add Session (Agregar sesion)

El boton Add Session (Agregar sesion) abre el cuadro de dialogo Session (Sesién) a través del
cual el usuario puede configurar una nueva conexion a una entidad de aplicacién DICOM remota.

Para crear una nueva configuracion de conexién a una AE de DICOM remota, el usuario debera
tener disponible la siguiente informacion: Application Entity Title (AE Title) (Titulo de la entidad
de aplicacién [titulo AE]), la eleccion de «function to perform» (Funcién que se va a realizar) de
DICOM/SACI, IP Address (direccion IP) y Port Number for the Sever (Nimero de puerto para
el servidor [es decir, la impresora DICOM o el sistema SACI]).

El titulo AE y el numero de puerto del sistema del usuario (es decir, el cliente) también son
obligatorios. Para crear una nueva configuracion, rellene los campos de datos pertinentes y
seleccione OK (Aceptar).

Seleccion del comportamiento de la funcidon de sesion
predeterminada de DICOM/SACI Figura 5.7.6

Actualmente existen cuatro (4) tipos de funciones | s DICOM Session Properties e Cuadro de dialogo Propiedades
que una sesion DICOM puede representar por | e | T de la sesion

defecto. Estos se encuentran en la lista desplegable Server ——
Function (Funcién) (cuadro combinado) que se P P E—

muestra en la siguiente figura. También hay una lista

. L, Functior: GEMERAL -
a continuacion: GENERAL
STORE
. . |PRIMT
1. Una conexion DICOM/SACI GENERAL IPAddess: ), ORKLIST

Part Number: |0

2. Una conexion ALMACENAMIENTO EN DICOM

. s Client
3. Conexion de una IMPRESORA DICOM e T
4. Una conexién LISTA DE TRABAJO de modalidad PortNumber [T
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El propésito de la «funcién» DICOM es permitir la creacion de una sesion o conexion (afiadida)
que permita que un «dispositivo» DICOM/SACI solamente pueda ser utilizado tal y como el
usuario lo ha configurado para una categoria de funcién en particular. Una vez configurado, al
visualizar o utilizar «DICOM Networking Dialog» (cuadro de dialogo Conexiones de red de
DICOM) (véase la Figura 5.7.5 anterior), solamente estara «activo e iluminado» el icono
correspondiente a la funciéon elegida. Es decir, tendra un color azul en lugar de un color
«grisaceo». Por ejemplo, en la Figura 5.7.5 superior hay tres (3) iconos que representan, en
orden: un almacenamiento en DICOM (DICOM Store 1), una impresién en SACI (DICOM Print
1) y una lista de trabajo de modalidad (DICOM-MWL). Debido a que el botén DICOM Store
(Almacenamiento en DICOM) fue elegido previamente, es el Unico que esta activo (pantalla
azul). Asimismo, funciona igual para los otros modos.

Modify Session (Modificar sesion)

El boton Modify Session (Modificar sesion) abre el cuadro de didlogo para la entidad de
aplicacién (AE) de DICOM seleccionada. En esta ventana, el usuario puede modificar la
informacién del servidor y del cliente descrita en la descripcion de Add Session (Agregar
sesion).

Remove Session (Eliminar sesién)

El botén Remove Session (Eliminar sesion) elimina la configuracion de la entidad de aplicacion
(AE) de DICOM seleccionada en el software Vision. Una vez eliminada, la configuracién de la
entidad de aplicacion (AE) de DICOM no se podra restaurar a menos que el usuario vuelva a
introducir manualmente los datos necesarios mediante el boton Add Session (Agregar sesion).
Se solicitara una confirmacién de la accion; véase mas adelante.

r N
Vision l'*"-""'""J

:I Are you sure you want to remove this DICOM Network Connection?

Figura 5.7.7

Verificacion de la eliminacion de
una conexioén de red DICOM

existente
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Association (Asociacion) 5.7.0 Cont.

El boton Association List (Lista de Asociaciones) abre el cuadro de didlogo Association
(Asociacion), representado abajo, mediante el cual el usuario puede editar los parametros y
protocolos utilizados por el software Vision cuando negocia una conexién con una entidad de
aplicaciéon (AE) de DICOM remota. Estas opciones solamente deben ser modificadas por un
usuario avanzado que esté familiarizado con los protocolos de asociacién de DICOM.

~ Figura 5.7.8
E DICOM Association S| Ventana Asociacién DICOM

Wersion: 1

Application Contest: |1 .2.84010008.2.1.1.1 o]
b ax Data Lenagth: 16354 ¥ Enabled

Implementation Class: |1.2.84D.11425?.1123455 ¥ Enabled

Implementation Yersion: |1 [¥ Enabled

i ax Operation lrvoked:
tdax Operation Performed:

Abstract Syntax:

" Enabled

Yerific.ation Class
B asic: Film Session Class

Select Al
B asic: Film Box Clazs ‘
Bazic Grayzcals Image Box Clazs = Deselect Al
Bazic Grayzcals Print banagement Meta Class Wi
Frint Job Clazz oo
Basic Annotation Box Clazs
Printer Clazs

4 T | b

Timeout [rns]: E0000

M| »

Film Attributes (Atributos de la pelicula)

Al seleccionar «SET DICOM PRINT FILM Attributes» (Ajustar atributos de la pelicula de la
impresora DICOM) en el mend « COMMAND» (Figura 5.7.9) aparecera el cuadro de dialogo
DICOM Printer Setup (Configuracion de la impresora DICOM). Véase la Figura 5.7.10. En este
cuadro de dialogo, el usuario podra seleccionar varias opciones que rigen el formato de la
pelicula y la impresién. Al seleccionar Default (Predeterminado), se restauran todas las
opciones predeterminadas. Las configuraciones de los ajustes se proporcionan a través de
menus desplegables. Para aceptar la configuracion modificada, seleccione OK (Aceptar). Para
rechazar las opciones y salir de la ventana sin realizar ninguna modificacion, seleccione Cancel

(Cancelar). Figura 5.7.9

Establecer los atributos de la

;':__.l, DICOM Metworking Dialog - Bioptics Vision N )
pelicula de la impresora DICOM

SESSION  SECURITY VIEW = COMMAND PREFERENCES
ECHO ON/OFF

| CHECK ASSOC. FOR STORAGES
ADD Session |
SELECT DICOM File & DICOM STORE
MODIFY Session | E DICOM STORE Selected
REMOVE Session | SELECT DICOM File & DICOM PRINT
ASSOCIATION List | SET DICOM PRINT FILM Attributes

| DICOM C-FIND Patient Root...
DICOM C-FIND Study Roct...
DISCOMMECT O CEID Patient <t Ot

ECHO ON/OFF | DICOM C-FIND Modality Worklist...
I M INF | DICOM RETRIEVE

CANCEL Command
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DICOM Printer Setup X
Figura 5.7.10
: Cuadro de diglogo Configuracion
Medium Type X de la impresora DICOM
Print Priority [High -

MNumber of Copies |1

Film Destinatian |Magazine

Film Orientation [Portrait

Empty Image Density |El|ack

Border Density |Ellack
tagnification Type |REPL|CATE
Film Size ID [aix1 oM
Falarity |N0rmal
Srnoothing Type |Medium

Filrm Density

hax Density WLJ
tin Density |0 4

Image Display Format

=
@ STANDARD, m m

i~ Slide

Default

-k [ 1t b e e e e e 1

]

Cancel

PACS Print (Impresién en SACI)

La opcién PACS Print (Impresién en SACI) envia la imagen seleccionada a la impresora SACI
DICOM seleccionada. La imagen se imprimird de acuerdo con las opciones de formato de
pelicula y de impresion que se encuentran en el cuadro de didlogo Set Film Attributes
(Establecer atributos de pelicula) descrito anteriormente. Si el usuario inicia la impresiéon en
SACI desde Image View (Vista de imagen), el nivel de la ventana sera elegido desde la vista
de imagen. Si la impresién en SACI se inicia desde el didlogo de base de datos, el nivel de
ventana sera el nivel de ventana por defecto calculado por el software Vision.

Close (Cerrar)

El botén Close (Cerrar) cierra el cuadro de dialogo DICOM Networking (Conexiones de red de
DICOM) y devuelve al usuario al area desde la que se ejecutd el comando DICOM. Este
comando también cerrara la conexién o asociacion entre el software Vision y el dispositivo
DICOM remoto, si se ha establecido una conexion.
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Descripcion general 5.8.0

Las anotaciones de usuario dentro del software Vision permiten aplicar a una imagen una
«sobreimpresion» grafica transparente, comunmente Illamada «anotaciones». Estas
anotaciones adoptan la forma de texto, lineas, lineas de «forma libre» (curvas de Bezier),
flechas, elipses y cuadros. Esto permite afiadir informacién adicional y «marcadores» a la
imagen, si se desea. Tenga en cuenta que todas las anotaciones se pueden activar o desactivar
facilmente; en otras palabras, se pueden mostrar u ocultar a voluntad.

Funcionamiento

Para comenzar a anotar, seleccione la herramienta Annotations (Anotaciones) del menu de
la izquierda. Véanse las Figuras 5.4.1 y 5.8.1. Al abrir este cuadro de didlogo, el software
pondra inmediatamente al usuario en modo de disefio. También mostrard una «paleta de
herramientas». Véase la Figura 5.8.2 siguiente.

Al seleccionar Save (Guardar) o Cancel (Cancelar) en este cuadro de dialogo, se cancelaran
las anotaciones anteriores o se guardaran las anotaciones actuales en la ventana. También le
devolvera a usted al modo normal de obtencién de imagenes.

La paleta de herramientas consta de quince (15) opciones de herramientas que se muestran a
continuacién. Sin embargo, las herramientas pueden ser truncadas en funcién de las
necesidades del usuario a las 8 herramientas mas comunes, que se muestran en la fila superior
del cuadro de dialogo.

Tenga en cuenta que el comportamiento de la mayoria de estas opciones de herramientas
implica utilizar el ratén para guiar la posicion y la forma dinamica en pantalla. Los «clics» del
raton se utilizan para establecer la posicion y la forma definitivas. El término «deslizar» implica
mantener pulsado el botdn izquierdo del ratdon y mover el objeto por la pantalla. Si se suelta el
botdn izquierdo del raton o se hace clic con el botén derecho del raton, la anotacion se colocara
en una posicidon «permanente» o definitiva.

Mew Preset Name Here

Add as New Preset

Partiendo de la parte superior izquierda de la figura anterior, a continuacion se ofrece una
descripcion de cada opcion de herramienta.

Anotaciones del
usuario

Figura 5.8.1
Icono de Anotaciones

Figura 5.8.2
Paleta de herramientas de disefio
de anotaciones de usuario

HOLOGIC

MANUAL DE USUARIO DE FAXITRON PATH | HOLOGIC | REVISION 002

5-39



Faxitron’ Path Sottunne

Sistema de radiografia de muestras VISION

e Herramienta Selection (Seleccion): se utiliza para seleccionar (resaltar) un objeto de la
anotacion actual. Haga clic y mantenga pulsado el botén izquierdo del raton, que establece
una posicién inicial y, a continuacion, mueva el raton. Cualesquiera que sean las anotaciones
que se encuentren dentro del cuadro que se esta mostrando, seran seleccionadas para
utilizarlas posteriormente. Para finalizar la operacion, suerte el botdn izquierdo del raton.

e Herramienta Line (Linea): dibuja una linea recta con esta opcién. El comportamiento del
ratén es el mismo que el de arriba.

¢ Herramienta Box (Cuadro): dibuja un cuadro. EI comportamiento del ratén es el mismo que
el de arriba.

¢ Herramienta Ellipse (and Circle) (Elipse [y circulo]): dibuja una elipse o un circulo. El
comportamiento del ratén es el mismo que el de arriba.

e Herramienta Arrow (Flecha): dibuja una linea con una flecha al final. El comportamiento
del ratén es el mismo que el de la herramienta Line (Linea).

¢ Herramienta Polygon Open Line (Linea abierta poligonal): dibuja lineas no rectas
«segmentadas y abiertas». Haga clic con el boton izquierdo del ratén, mantenga pulsado el
botodn y dibujelo. Para fijar un segmento de linea, suelte el botdn izquierdo. Repitalo cuantas
veces lo desee. Haga clic con el boton derecho del raton y la operacion de la herramienta
habré finalizado.

e Herramienta Text (Texto): crea un «cuadro de texto» donde se pueden escribir datos
basados en texto.

¢ Herramienta Ruler (Regla): crea un segmento de lineas paralelas. Muy parecida a la
funcion Image Tools Ruler (Regla de herramientas de imagen).

e Herramienta Polygon Closed Line (Linea cerrada poligonal): dibuja lineas no rectas
«segmentadas y cerradas». Haga clic con el botén izquierdo del raton, mantenga pulsado el
botdn y dibujelo. Para fijar un segmento de linea, suelte el botdn izquierdo. Repitalo cuantas
veces lo desee. Haga clic con el boton derecho del raton y la operacion de la herramienta
habra finalizado.

¢ Herramienta Curved Open Line (Linea curva abierta): dibuja lineas curvas «abiertas y
segmentadas» (Curvas de Bezier). Haga clic con el botén izquierdo del ratén, mantenga
pulsado el botén y dibujelo. Para fijar un segmento de linea curva, suelte el botén izquierdo.
Repitalo cuantas veces lo desee. Haga clic con el botén derecho del ratén y la operacién de
la herramienta habra finalizado.

e Herramienta Curved Closed Line Tool (Linea curva cerrada): dibuja lineas curvas
«segmentadas y cerradas». (Curvas de Bezier). Haga clic con el botén izquierdo del raton,
mantenga pulsado el botén y dibujelo. Para fijar un segmento de linea curva, suelte el boton
izquierdo. Repitalo cuantas veces lo desee. Haga clic con el botén derecho del ratén y la
operacion de la herramienta habra finalizado.

¢ Herramienta Text «Balloon» (Globo de texto): crea un cuadro de texto con un segmento
de linea que sobresale de una esquina del cuadro de texto. Esto se puede utilizar para
«enlazar» texto a algo que esté en la imagen que usted haya obtenido.

o Segmented Ruler (Regla segmentada): dibuja lineas no rectas paralelas «abiertas y
segmentadas». Haga clic con el botén izquierdo del ratéon, mantenga pulsado el botdn y
dibujelo. Para establecer un segmento de lineas paralelas, suelte el botén izquierdo. Repitalo
cuantas veces lo desee. Haga clic con el botén derecho del ratén y la operacion de la
herramienta habra finalizado. La longitud de todos los segmentos de lineas paralelas se
muestra al final de la regla. Util para una estimacion aproximada de la periferia de un objeto
0 paciente.

¢ Herramienta Protractor (Escuadra): dibuja un angulo en la pantalla y proporciona el grado
del angulo. Igual que una escuadra.

e Herramienta Orthogonal Ruler (Regla ortogonal): Proporciona dos (2) lineas paralelas
que son ortogonales entre si.
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Modo de disefio y menu contextual del ratén 5.8.0 Cont.
En el modo de disefio de anotaciones de usuario, pero no en un modo de operacion especifico,
se puede hacer clic con el botén derecho del raton y obtener un menu contextual. Véase mas
abajo.
Name.. Figura 5.8.3

Line...

ROP2...

Transparent

Transparent Color...

Fill...

Foreground Color...
Background Color...

Text Color...

Mote Background Color..,
Redact Background Color...
Hilite Background Celor...
Font...

Button Font...

Unde Hotspot Metafile...

Cut Encrypt Metafile...

Copy Decrypt Metafile...

Paste Ruler...

Delete Modes...
Protractor...

Select All
Show Stamp Border

Bring to Front Point...

Send to Back

Encrypt...
Hide Rotate Handles for All Objects Fixed...
Default Properties » Hyperlink...

Desde estos menus contextuales se pueden realizar muchas configuraciones especificas.

Nota: Si un elemento parece demasiado pequefo para leerlo o verlo correctamente, usted lo
podra cambiar desde los menus contextuales del raton mostrados mas arriba. De forma
alternativa, podra elegir hacer zoom en la imagen utilizando la herramienta Dynamic Zoom
(Zoom dinamico). Esto ampliara la imagen y usted deberia poder ver claramente cualquier
anotacion.

Mostrar u ocultar las anotaciones

El botén Toggle Annotations (Alternar anotaciones), que se muestra en la

Figura 5.8.4, permite a los usuarios activar y desactivar rapidamente las
anotaciones. Por defecto, las anotaciones estaran activadas. El botén se encuentra @
en el menu del lado derecho, cerca de la esquina superior derecha.

Clic con el botén derecho del
ratén en el menu contextual
(solamente durante el modo de
disefio de las anotaciones de
usuario)

Figura 5.8.4
Opcion mostrar/ocultar para las
anotaciones del usuario
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Faxitron" Path

SECCION

Software
Sistema de radiografia de muestras VISION
El submenu «Help» (Ayuda), véase la Figura 5.9.1, se encuentra en la barra de menu superior 590

y permite un acceso rapido al «User’'s Manual» (Manual de usuario) y a «About Vision» (Acerca
de Vision) de Faxitron Path. Consulte la Seccién 5.10.0 y la Figura 5.10.1.

Open User's Manual

About Vision

El boton «About Vision» (Acerca de Vision) abre un cuadro de dialogo que muestra la versiéon
del software Vision, la fecha de la propiedad intelectual y la informacién del sistema.

About Vision >

[:] Vision Version 3.1.4 Revl U (84-Bij

Copyright (C) 2005-2018 Faxitron Bioptics LLC

— Processing Library Information
Yersiond 3.0.3.1 MName: FEProcessing.dll

——— Camera Library Information
Yersiond 1.0700 Mame: BiCamTLDS.dll

Canfiguration Utility Information
“Yarsion# 1.2.1.1

———— Camera Infarmation

Make: Teledyne Dalsa, Serial# SERIAL#
Madel: xineos 2923

Sensortype: TDOLS_2304x2944

—— »-Ray System Infarmation
hake: BIOFTICE, hodel: PATHWISION
Firrmware Wersion# PAT01.05

Acerca de la Ayuda

Figura 5.9.1
Cuadro de diélogo Ayuda en linea

5.10.0
Acerca del
software Vision

Figura 5.10.1

Cuadro de dialogo con
informacion acerca de Vision
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Faxitron® Path SEecon 6

Sistema de radiografia de muestras y seguridad

SECCION 6

Requisitos de
cumplimiento y medidas de
seguridad
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FaXitl’O n® Path Conformidad

Sistema de radiografia de muestras y seguridad

Requisitos | Cumplimiento de Faxitron Path

Limites de emision Reqws.ltc.)s de
La radiacién de rayos X emitida por la unidad Faxitron Path no excede una exposicion de cumpllmlento y
0,1 mili-Roentgens (mR) por hora en cualquier punto a 5 centimetros (cm) (2 in) fuera de la medidas de
superficie externa. Para los paises que exigen valores de emision medidos a 10 cm de la seguridad
superficie exterior, la radiacion no supera los 0,1 mR por hora a 10 cm.

Enclavamientos de seguridad
El sistema Faxitron Path de radiografias digitales de especimenes tiene dos enclavamientos
de seguridad en la puerta de los especimenes.

Botén Start (Inicio)
Tras la interrupcidn de la generacion de rayos X por los enclavamientos de seguridad, el botén
Start (Inicio) del panel frontal reanudara la generacion de rayos X cuando esté listo.

Control accionado por llave

El interruptor de cerradura con llave situado en el panel frontal requiere que se inserte y se
gire una llave en el sentido de las agujas del reloj hasta la posicion de las 3 para suministrar
energia al sistema de armario. La llave se mantiene fijada en la posicion « ON».

Botén Emergency Stop (Parada de emergencia)

En el panel frontal, Faxitron Path incluye el boton Emergency Stop (Parada de emergencia)
para detener la generacion de rayos X. Esto se suma a los enclavamientos de seguridad de
las puertas del sistema.

Indicadores de generacion de rayos X
El Faxitron Path tiene un indicador luminoso de rayos X en el panel frontal y en la interfaz
grafica de usuario, y produce también un tono audible cuando se generan los rayos X.

Potencias nominales
Maximo de 100-240 VCA, 50/60 Hz, 200 W

Potencia calorifica
Maximo de 527,5 kJ/h (500 BTU/h)

LOCALIZADOR LASER
El Faxitron Path utiliza un par de lineas generadas por laser que facilitan el posicionamiento
de las muestras en el centro del campo de generacion de imagenes.

Parametros del laser

Cumple con la norma IEC 60825-1: Edicion 3
Producto laser de clase 2

Longitud de onda: 670 nm

Potencia maxima: 1 mW

Anchura de linea: tipicamente, 1 mm
Divergencia del rayo: tipicamente, 85°

Los laseres no requieren montaje.

No hay un proveedor autorizado de mantenimiento para los laseres. El mantenimiento de los
laseres debe llevarlo a cabo Unicamente un representante autorizado de Hologic.

PARAMETROS ELECTRICOS DEL LASER

Tension de funcionamiento:  Rojo, 3-6VDC
Negro, Tierra

Corriente de funcionamiento: tipicamente, 50 mA
maxima, 80 mA
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Faxitron® Path

Sistema de radiografia de muestras

Conformidad
y seguridad

PRECAUCIONES:

RADIACION LASER DE CLASE 2 CUANDO LA PUERTA ESTA ABIERTA. NO MIRE

FIJAMENTE AL RAYO.

Los rayos laser pueden provocar dafios en los ojos, NO mire a la abertura del laser mientras

este esté en funcionamiento.

Tenga en cuenta que la luz laser también puede ser peligrosa si se refleja en una superficie

similar a un espejo.

Para obtener mas informacion acerca de los laseres, ponsulte la NORMA NACIONAL
NORTEAMERICANA PARA EL USO SEGURO DE LASERES ANSI Z1 36.1, disponible a
través del Laser Institute of America (teléfono 407-380-1553).

NOTA: Las aberturas del laser se encuentran en la parte superior del compartimento de rayos X.

Etiqueta de PRECAUCION del laser: Situado en la esquina superior derecha de la puerta y

detras de esta.

<Emm AVOID EXPOSURE

LASER RADIATION IS
EMITTED FROM THIS APERTURE

LASER RADIATION
AVOID DIRECT EYE EXPOSURE
CLASS 2 LASER PRODUCT
PEAK POWER 1mW
WAVELENGTH 670nm

|EC 60825-1:2014

COMPLIES WITH 21 CFR 1040.10
AND 1040.11 EXCEPT FOR DEVIATIONS
PURSUANT TO LASER NOTICE NO.50,
DATED JUNE 24, 2007

Translations in Box

LBL-11347 Rev. 002

LASER RADIATION
AVOID DIRECT EYE EXPOSURE
CLASS 2 LASER PRODUCT
PEAK POWER 1mW
WAVELENGTH 670nm

IEC 60825-1:2014

Translations in Box

COMPLIES WITH 21 CFR 1040.10
AND 1040.11 EXCEPT FOR DEVIATIONS
PURSUANT TO LASER NOTICE NO.50,
DATED JUNE 24, 2007

/ACAUTION

CLASS 2 LASER RADIATION WHEN OPEN
DO NOT STARE INTO THE BEAM

LBL-11353 Rev. 002
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Faxitron® Path SEccon

Conformidad

Sistema de radiografia de muestras y seguridad
_ 6.2.0
Versiéon de DICOM Estandar DICOM

Hologic utiliza el ultimo estandar DICOM:

Imagenologia Digital y Comunicaciones en Medicina (DICOM) v3.0, desarrollado por ACR-
NEMA, version definitiva, agosto de 1993.

Y cumple el estandar:

NEMA PS 3.1-3.20 (2016), Equipo de Imagenologia Digital y Comunicaciones en Medicina

Clases de almacenamiento

FAXITRON_DR cumple la norma relativa a la siguiente clase SOP (par servicio-objeto) de
DICOM V3.0 como SCU (usuario de clase de servicio).

Clase SOP como SCU

Clase SOP UID (identificador unico) de clase SOP

SOP de almacenamiento de imagenes de 1.2.840.10008.5.1.4.1.1.1
radiografias computarizadas
Presentacion del almacenamiento digital de 1.2.840.10008.5.1.4.1.1.1.1
imagenes realizadas con rayos X
Procesamiento de imagenes digitales realizadas |1.2.840.10008.5.1.4.1.1.1.1.1
con rayos X
Presentacion del almacenamiento de imagenes [1.2.840.10008.5.1.4.1.1.1.2
digitales de mamografias realizadas con rayos X
Procesamiento de imagenes digitales de 1.2.840.10008.5.1.4.1.1.1.2.1
mamografias realizadas con rayos X
Consulta o recuperacion de la informacién raiz  (1.2.840.10008.5.1.4.1.2.2.1
del estudio. Modelo -FIND
Consulta o recuperacion de la informacién raiz  (1.2.840.10008.5.1.4.1.2.1.1
del paciente. Modelo -FIND
Modelo -FIND de informacién de las listas de 1.2.840.10008.5.1.4.31
trabajo de las modalidades
Almacenamiento de la presentacion de las 1.2.840.10008.5.1.4.1.1.11.1
copias digitales en escala de grises

Para conocer mas detalles, consulte en su totalidad la Declaracion de Conformidad de
DICOM, que esta almacenada en el sistema. El archivo esta en C:\Faxitron, y hay un acceso
directo en el escritorio.

Si la necesita, puede solicitar a Hologic una copia de la declaraciéon de conformidad de
DICOM.
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Faxitron® Path Vomonimionto y 7

Sistema de radiografia de muestras resolucion de problemas

SECCION 7
Mantenimiento y
resolucion de problemas
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FaXitl’O n® Path Mantenimiento y

Sistema de radiografia de muestras resolucion de problemas

Mantenimiento

Mantenimiento
En los equipos Hologic no hay piezas que se puedan reparar. Para recibir asistencia técnica, y

pongase en contacto con el representante autorizado de Hologic. resolucion de
problemas

EE. UU.: +1.877.371.4372

Europa: +32 27114690

Asia: +852 37487700

Australia: +1 800 264 073

Resto del mundo:  +1 781 999 7750

Correo electrénico:  BreastHealth.Support@hologic.com

Solucion de problemas

El ordenador o el sistema no se encienden
El ordenador o el sistema de rayos X no estan recibiendo alimentacion eléctrica.
Compruebe que el sistema esté encendido y que la regleta esté enchufada y encendida.

La luz LISTO no permanece encendida
Se presiond el botdon ANTES de que el software Vision estuviera en marcha o antes de que
preparara el sistema de rayos X para obtener una imagen. Consulte la seccion Inicio rapido.

En la imagen parece como si en la radiografia hubiera otro objeto
Compruebe si durante la calibraciéon habia algun objeto en el armario de rayos X. Retire
cualquier objeto y repita la calibracién.

La imagen tiene mala calidad

Compruebe que los valores de intensidad de la imagen (I (x,y)) que se encuentran en la
esquina inferior derecha de la ventana de visualizacion de la imagen estén cerca de
10 000 UAD, que el objetivo AEC predisparado esté también ajustado a 10 000 UAD y que el
modo de exposicion esté seleccionado como Auto kV/Auto Time (kV automatico/tiempo
automatico). Si fuera necesario, repita el procedimiento de obtencién de imagenes.

Ciberseguridad

Si se produce un evento de ciberseguridad, desconecte de la red el sistema y pongase
inmediatamente en contacto con Hologic. Trabajaremos con el departamento de Tl del centro
para resolver el problema.

Un evento de ciberseguridad puede detectarse de varias maneras:
e El funcionamiento y/o la conexién de red son mas lentos de lo normal.

e En el navegador de Internet aparecen ventanas emergentes sospechosas o la
pagina de inicio ha cambiado.

e La(s) contrasefia(s) ya no funciona(n).
e En el menu de inicio o en la bandeja del sistema hay programas desconocidos.

e Los datos se han perdido, dafiado o alterado.
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Faxitron® Path SEecon. 8

Sistema de radiografia de muestras mantenimiento

SECCION 8
Programa de
mantenimiento
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Faxitron® Path Programa de

Sistema de radiografia de muestras mantenimiento

Este documento proporciona un programa de pruebas y mantenimiento para Faxitron Path.
Para garantizar que el generador de rayos X Faxitron siga funcionando con un rendimiento
6ptimo, se recomienda encarecidamente que el mantenimiento y las pruebas descritas en esta
seccion se realicen en los intervalos de tiempo indicados.

Mantenimiento

Advertencia: las muestras que contienen tejidos pueden albergar agentes
infecciosos que son peligrosos para la salud. Siga los correspondientes
procedimientos de bioseguridad; cuando manipule especimenes de tejido o los &
materiales con los que entren en contacto, utilice guantes.

Limpie periddicamente el interior del armario con alcohol isopropilico al 70-90 % o hipoclorito
de sodio diluido (la lejia doméstica al 5,25 %-6,15 % diluida en la proporciéon 1:500 ofrece la
concentracion adecuada). Asegurese de que el area de especimenes, marcada en la base de
la camara, esté bien limpia.

No utilice acetona ni otros disolventes agresivos en la ventana de la puerta del compartimento
de rayos X.

Interno

Limpie periddicamente las superficies exteriores con alcohol isopropilico, hipoclorito de sodio,
0 agua con jabdn suave (consulte las concentraciones adecuadas en la seccion 8.1.0). No
empape ni inunde las superficies, ni utilice abrasivos que puedan rayarlas. No permita que la
humedad entre en contacto con ninguno de los componentes eléctricos del sistema. Para
verificar que no deterioran el acabado, pruebe los productos de limpieza en un area pequefia
y poco visible de las cubiertas metalicas y de plastico.

Exterior

A excepcion de los cables y fusibles externos, el sistema no tiene componentes que el usuario
pueda reemplazar. A continuacién, se enumeran los articulos que se pueden pedir para que
personal de Hologic o representantes autorizados los sustituyan.

o Detector de rayos X digital

e Tarjeta de interfaz PCle

e  Ordenador, monitor, ratén y teclado

e Placa de circuito impreso del controlador

e Tubo de rayos X y fuente de alimentacion de alta tension

e Fuente de alimentacion de baja tension

Piezas sustituibles

¢ Obijetivo acrilico de dispersion (~6 mm [0,25 in] y ~24 mm [1 in] de grosor)

e Fantoma ACR (n.° de referencia de Nuclear Associates 18-250)

e Dosimetro de camara de ionizacién, modelo 451B-DE-SI-RYR de Inovision o similar
¢ Jarra de plastico con capacidad para 4 litros (1 galén) de agua

Materiales
necesarios

En las siguientes referencias se proporciona mas informacion sobre los procedimientos de
seguridad del software que se describen en este documento.

Seguridad y ciberseguridad
En caso necesario, se proporcionara cualquier actualizacion de software o firmware distribuida
desde el ultimo mantenimiento en que se haya resuelto un problema de seguridad.

El firmware esta codificado de forma fija en la placa de control, por lo que, en caso de que sea
necesaria una actualizacion del mismo, debera sustituirse la placa de circuito impreso del panel
de control.

Documentos de
referencia e
informacion sobre
la version
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Faxitron® Path Programa de

Sistema de radiografia de muestras mantenimiento

A continuacion, se incluyen las definiciones de los términos tal y como se aplican en este

Programa de mantenimiento. Definiciones

AEC: Automatic Exposure Control (control automatico de la exposicion): interrupcién de los
rayos X llevada a cabo por el ordenador cuando la sefial suficiente alcanza el sensor.

Ampliacion: movimiento del objeto lejos del sensor y hacia la fuente de rayos X para ampliar
la imagen del objeto en el detector.

Campo plano: correcciones de ganancia y compensacion que se realizan pixel a pixel. La
ganancia y compensacion de cada pixel son diferentes, por lo que debe calibrarse.

Contraste: diferencia porcentual entre la intensidad del objeto y la intensidad del fondo.
Corriente oscura: sefial térmica que se genera en el sensor; (casi) lineal con el tiempo.

Fantoma ACR: fantoma acreditado por el American College of Radiology (Colegio de
Cardiologia de los Estados Unidos).

Funcién de transferencia de modulacién, (MTF, por sus siglas en inglés): medida del
contraste y la resolucion de un sistema de obtencion de imagenes.

Pares de lineas por milimetro: nimero de porciones llenas y vacias alternas. Por ejemplo,
10 Ip/mm significa => {vacial/llena} {vacia/llena}... 10 veces en un milimetro.

Radiografia de un espécimen: obtencién de imagenes de rayos X de una porcion de tejido
extraida del cuerpo.

ROI: regidn de interés. Por norma general, una subregion especifica de una imagen.
Ruido de lectura: medida del ruido RMS en una exposicidon oscura de 0 segundos (sin sefal).
SID: distancia de la fuente a la imagen; distancia desde la fuente de rayos X al detector.

UAD: unidades analdgico-digitales.

El mantenimiento peridédico debe realizarse anualmente para garantizar que el sistema
Faxitron Path siga funcionando de forma 6ptima a lo largo del tiempo. Dicho mantenimiento

periddico incluye la comprobacidon de lo siguiente: Mantenimiento

_ o _ . periédico
e enclavamientos e indicadores de seguridad, Seccion 8.8.0;
e prueba de fantoma ACR (verifica el rendimiento de la cdmara), Seccién 8.8.1;y

e estudio radiografico, Seccion 8.8.2.

Recomendamos realizar estos procedimientos de forma anual; no obstante, las normativas
gubernamentales podrian requerir programas de mantenimiento mas frecuentes.
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Faxitron® Path Programa de

Sistema de radiografia de muestras mantenimiento

Enclavamientos, luces, mensajes de error; a realizar anualmente.

Enclavamientos e
indicadores de
seguridad

Si fuera necesario, imprima esta pagina para utilizarla como referencia.

Anote los resultados en el apartado «Enclavamientos e indicadores de seguridad» del Registro
del mantenimiento periédico de Faxitron Path que se encuentra al final de la seccién.

1. El sistema debe estar encendido. El interruptor de cerradura con llave debe estar en la
posicion de las tres y la llave debe estar fijada.

2. Compruebe que el LED de encendido esté iluminado. Ningun otro LED deberia estar
iluminado en ese momento.

3. Compruebe que la pantalla LCD se ilumine y muestre «System Idle» (Sistema inactivo), y
que no haya ningun otro mensaje, como «Door Open» (Puerta abierta).

4. Abra la puerta de los especimenes. La pantalla LCD mostrara el mensaje «Door Open»
(Puerta abierta). Cuando se cierre la puerta, el mensaje deberia desaparecer.

5. Encienda el ordenador y el monitor. El software Vision deberia iniciarse automaticamente.
Si no se inicia automaticamente, haga doble clic en el icono del software Vision para iniciar
el software de obtencion de imagenes. Si, al hacerlo, se inicia una calibracién, permita que
se realice por completo.

6. A continuacion, haga clic en el botdon Start Procedure (Iniciar procedimiento) y, después,
en el botén Patient Data (Datos del paciente), y seleccione el botén Enter Manually
(Introduccion manual) para acceder a la pantalla de entrada del paciente. Cumplimente
todos los campos marcados con un asterisco (*) y haga clic en el botén Accept (Aceptar).
Esto permitira que se lleve a cabo una exposicion.

7. Compruebe que el LED «Ready» (Listo) esté encendido. En la pantalla LCD también se
mostrara el mensaje «Ready» (Listo).

8. Pulse el botén verde «X-ray» (Rayos X) que esta en la parte frontal del Faxitron Path. El
sistema deberia comenzar una exposicién a los rayos X. Asegurese de que en la pantalla
LCD aparezca una barra indicadora de la exposicién, asi como los kV y el tiempo de la
misma. Compruebe también que el LED «X-Ray On» (Rayos X encendidos) se encienda.
Ademas, durante la exposicion, deberia escucharse un pitido breve una vez por segundo.
Espere a que la exposicion finalice y asegurese de que la imagen aparezca en la pantalla
del ordenador.

9. Vuelva a pulsar el botdn verde para iniciar otra exposicion. Mientras se esté produciendo
la exposicion, pulse el botén rojo «Stop» (Detener). La exposicién deberia detenerse
después de pulsarlo durante 2 segundos. El timbre dejara de sonar para indicar que la
exposicion se ha detenido. El software mostrara errores de interrupcion, lo que es
perfectamente normal. Al eliminarlos, se podran volver a realizar radiografias.

10.Vuelva a pulsar el botdn verde para iniciar la exposicion. En esta ocasion, abra la puerta

de los especimenes. Esto deberia soltar los interruptores de seguridad y forzar la parada
de la exposicion. Es posible que el software muestre errores, eliminelos.
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Faxitron® Path gg;§$2§e

Sistema de radiografia de muestras mantenimiento
Fantoma ACR (solo insertos de cera); a realizar anualmente. 8.8.1

. o - " . Prueba de fantoma
Si fuera necesario, imprima esta pagina para utilizarla como referencia. ACR
Anote los resultados en el apartado «Prueba de fantoma ACR» del Registro del mantenimiento
periédico de Faxitron Path que se encuentra al final de la seccion.
El usuario debe estar familiarizado con el uso de Faxitron Path y conocer los procedimientos
para tomar radiografias. Complete los procedimientos de configuracién y asegurese de que la
camara esté calibrada (tenga en cuenta los kV y el tiempo de calibracion). Introduzca los datos
del paciente y tome una fotografia de una porcién del inserto de cera del minifantoma ACR
que se muestra en la Figura 8.1 NOTA: Para realizar la imagen debera retirarse el inserto de
cera de su soporte acrilico.

Figura 8.1

Imagen de rayos X tipica del
inserto de cera del minifantoma
ACR (n.° de referencia de
Nuclear Associates 18-250)

El minifantoma ACR contiene doce
objetos: cuatro masas, cuatro fibras y
cuatro grupos de calcificaciones
(manchas). Por su parte, cada grupo de
calcificaciones contiene seis
calcificaciones o manchas diferentes.
Todas las masas, fibras y calcificaciones
deben ser visibles.

Nota: El ultimo grupo de calcificaciones
podria no ser visible en esta imagen.

REQUISITOS DE ACEPTACION

1. Configure el sistema para tomar una imagen manual del inserto de cera del minifantoma
ACR. Ajuste los kV y el tiempo segun lo observado durante la calibracién.

2. Asegurese de que el fantoma esté limpio y sin residuos.

3. Coloque el inserto de cera directamente en la base del compartimento, en el centro del area
de imagen. No utilice bloques atenuadores.

4. Encienda los rayos X y espere a que se complete todo el proceso y se muestre la imagen.

5. Al principio de mostrarse la imagen, es posible que no todos los objetos del fantoma sean
visibles. Ajuste los niveles de contraste y de brillo seguin sea necesario para obtener la mejor
imagen posible.

6. Una vez corregida la imagen, todos los grupos de objetos deberian ser visibles.

7. Anote los resultados en el Registro del mantenimiento periddico.
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FaXitrO n® Path Programa de

Sistema de radiografia de muestras mantenimiento

Estudio radiografico; a realizar, como minimo, anualmente, o en caso de que el
dispositivo se caiga o sufra algun daio.

Puede imprimir las siguientes paginas para utilizarlas como instrucciones para realizar el
estudio radiografico.

Anote los resultados en el apartado «Estudio radiografico» del Registro del mantenimiento
periddico de Faxitron Path que se encuentra al final de esta seccion.

Para garantizar que las emisiones de radiacion estén dentro de los limites necesarios, el
fabricante recomienda que se realice al menos un estudio radiografico al afio*. Si la maquina
sufre alguna clase de dafo tras su instalacion, debera realizarse un estudio radiografico antes
de volver a ponerla en funcionamiento en las instalaciones.

Herramientas necesarias

e Dosimetro radiografico con fuente de comprobacién (se recomienda un dosimetro de
camara de ionizacion como el modelo 451B de Inovision; el dispositivo incluye la fuente de
comprobacion).

e Jarra de plastico con capacidad para 4 litros (1 galén) de agua.

Comprobacion del funcionamiento del dosimetro
1. Fecha de calibracién: compruebe que la calibracion del dosimetro esté actualizada.

2. Revision de las pilas: compruebe el estado de las pilas. Si fuera necesario, reemplacelas.

3. Revisién del funcionamiento: (y de la fuente de comprobacion, si esta disponible). Nota:
Los siguientes pasos solo se aplican al modelo 451B de Inovision o a dosimetros de
camara de ionizacién similares. Para otros medidores, siga las instrucciones del
fabricante.

o Abra el protector beta deslizante situado en la parte inferior del dosimetro.

e Coloque el medidor sobre la fuente de comprobacion y monitorice durante
30 segundos.

e La lectura del dosimetro deberia encontrarse dentro de la tolerancia indicada en la
etiqueta de calibracion.

e Anote la lectura en el Registro del mantenimiento periédico.

o Cierre el protector beta del medidor.

Notas importantes:
1. Todas las medidas de radiacién se realizan con el dosimetro radiografico a no mas de 5 cm
(2 in) de distancia de la superficie de la unidad Faxitron Path.

2. Al anotar las medidas de radiacion, es posible que deba multiplicarlas por 0,1 para convertir

la lectura de ySv/h a mR/h. Por ejemplo, 12 uSv/h equivalen a 1,2 mR/h.

Estudio
radiografico
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Faxitron® Path

Sistema de radiografia de muestras

Programa de
mantenimiento

Procedimiento de estudio radiografico

1. Haga una lectura de la radiacion de fondo (con el medidor hacia el centro de la habitacion)
y anote el resultado.

2. Configure el sistema para tomar una imagen manual.

a.

C.

Haga clic en el boton Device Panel (Panel del dispositivo) y seleccione Full Manual
(Totalmente manual).

Arrastre los controles deslizantes de los kV y el tiempo tan a la derecha como es
posible para ajustarlos al maximo.

Haga clic en el boton «SET» (AJUSTAR).

3. Compruebe que el LED «Ready» (Listo) esté encendido.

4. Abra la puerta del compartimento. Coloque la jarra de plastico con 4 litros (1 galén) de agua
en el area de imagen de la base del compartimento y cierre la puerta.

5. Pulse el botéon «<START» (INICIAR) y mida las emisiones de radiacién en la parte superior,
frontal, posterior y en ambos laterales del armario. Analice lentamente toda la superficie con
el medidor. Cada analisis deberia tardar 1 o 2 exposiciones a los rayos X. Nota: Para
completar el estudio completo, tendra que iniciar los rayos X en varias ocasiones.

6. Anote las lecturas de cada lugar de la prueba.

7.Si cualquiera de las lecturas es superior al limite de radiaciéon de Hologic de 0,1 mili-
Roentgens (mR) por hora (1,0 uSv/h) en cualquier punto a 5 centimetros (cm) de distancia
de la superficie exterior (*), pongase en contacto con un representante de Hologic para
discutir las opciones de reparacion.

(*) El limite maximo fijado por el CDRH de la FDA de EE. UU. para los armarios de
rayos X es de 0,5 mR/h a 5 cm (2 in) de las superficies externas. Si se utiliza en otro
pais, consulte los limites oficiales vigentes para los equipos de radiografia para el
diagnéstico tipo armario.

En algunos paises, los puntos para la prueba deben situarse a 10 cm de las superficies
externas. En este caso, a 10 cm de las superficies externas, la lectura de la emision de
radiacion de los sistemas deberia ser inferior a 0,1 mR/h.

8. Retire la jarra de agua del compartimento de rayos X.

9.Si el sistema esta sobre una mesa o si hay personal en el piso inferior a donde este se usa,
debera realizarse un estudio de la parte inferior del armario de rayos X. Compruebe que no
haya nada en el compartimento de rayos X, inicie los rayos X y analice la parte inferior del
compartimento. Anote la lectura.
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Faxitron® Path Programa de

Sistema de radiografia de muestras mantenimiento

Registro del mantenimiento periddico de Faxitron Path

N.2 de serie del sistema: N.2 de serie de la cdmara:

Enclavamientos e indicadores de seguridad (Seccion 8.8.0)

Satisfactorio: Insatisfactorio: Iniciales: Fecha:

En caso de resultado insatisfactorio, indique las razones y las medidas emprendidas para corregir el fallo.

Iniciales: Fecha:

Prueba de fantoma ACR (Seccidn 8.8.1)
Numero de objetos observados: Masas: Fibras: Grupos de calcificaciéon:

Satisfactorio: Insatisfactorio: Iniciales: Fecha:

En caso de resultado insatisfactorio, indique las razones y las medidas emprendidas para corregir el fallo.

Iniciales: Fecha:

Estudio radiografico (Seccion 8.8.2)

Lectura de la radiacién en: |:| mR/h |:| uSv/h Fuente de comprobacién: _ De fondo:

Parte frontal: Lado derecho: Parte superior:
Parte posterior: Lado izquierdo: Parte inferior:
Satisfactorio: Insatisfactorio: Iniciales: Fecha:

En caso de resultado insatisfactorio, indique las razones y las medidas emprendidas para corregir el fallo.

Iniciales: Fecha:

El mantenimiento periddico identificado anteriormente fue completado por:

Fecha de realizacidn: Firma:
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